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Chapter 1. Introduction

Thisisthe SmartMDSD Toolchain User Manual. It contains information how to use the SmartMDSD
Toolchain for modeling, implementing and integrating SmartSoft software components. The Smart-
MDSD Tool chain guides through the devel opment workflow while applying the methods and princi-
ples from the SmartSoft World asthey are for example used within the FIONA Project.

Theinitial version of this document was published on March 30th 2016 as deliverable of the ITEA2
"FIONA" Project (Framework for Indoor and Outdoor Navigation Assistance, http://www.fiona-
project.eu): Deliverable D2.4.1"Handbook for Integrating Basic Services and | nterface Components”.
The presented document is the continuously updated version.

The manual isintended for users of the SmartMDSD Toolchain. For scientific contributions, please
refer to publications of SmartSoft and the SmartMDSD Toolchain. Some relevant publications are
also highlighted within the section 1.2.2.

The Introduction first sketches some very brief basics of the SmartSoft World. In chapter two, it
describes the SmartMDSD Toolchain from it's three main development perspectives: system design,
component development and integration by composition. The third part describes tutorials (in written
form and referenced video screencasts) to guide the reader through all these steps using a practical
real-world example. All parts of the handbook can be read in sequential order.

1.1. Fundamentals

1.1.1.

SmartSoft nowadays is an umbrella term for abstract concepts (such as a systematic development
methodology, best practices and implementations (reference implementations, a set of reusable com-
ponents) to build robotics systems. The SmartMDSD Toolchain is an Integrated Devel opment Envi-
ronment (IDE) for robotics software development. It seamlessly integratesinto the world of SmartSoft
by realizing the concepts of SmartSoft, thereby making them accessible to its users. [4]

The SmartSoft World

The SmartSoft World consists of several elements:

* SmartMARS MetaModel. It defines the structure for communication objects, a set of communica-
tion patterns, the structure of services and components, the structure for system configuration and
deployment.

» SmartSoft Framework and implementation. In its current state, two exchangeable reference imple-
mentations (ACE and CORBA middlewares). Execution containers for several platforms and oper-
ating systems. The SmartMDSD Toolchain currently supports SmartSoft/Ace.

* SmartSoft MDSD Toolchain. An Integrated Development Environment (IDE) for robotics software
devel opment that supports the separation of roles. The toolchain covers the devel opment process of
modeling communication objects, components and systems.

E Communication Object {I

Component 1 I::l - ‘,l::l Component 2

Service = Comm. Object
+ Comm. Pattern from predefined list

Figure 1.1. SmartSoft Component, Communication Objects and Services
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1.1.2.

1.1.3.

Components

Components are technically implemented as processes. A component can contain several threads and
interacts with other components via predefined communication patterns and communciation objects.
The component hull provides a stable interface between the internal structure of a component (inner
view of a component) and its outside view (services, for the system integrator). Within components,
component devel opersfind a structure to implement algorithms, reuse libraries and communicate with
other parts of the system through services. The SmartMDSD Toolchain assists in modeling and im-
plementing components. A set of existing components (SmartSoft SVN repository) is available for
immediate reuse and composition to applications from within the SmartMDSD Toolchain.

Services

A service is a combination of communication object(s) and communication pattern as defined by
SmartSoft. A communication pattern connects the externaly visible service (the stable outer view)
with the internally visible set of access methods (the stable inner view) for this service. Technically,
generic predefined communication patterns become services by binding one given communication
pattern with communication object(s).

1.1.3.1. Communication Objects

Communication objects define the data structure (content) to be transmitted via a communication
pattern between components. Communication objects are ordinary C++-like objects decorated with
additional member functions for data access and internal use by the framework.

Communication objects are always transmitted by value to avoid fine grained intercomponent com-
munication each time an attribute is accessed. Furthermore, object responsibilities are much simpler
with locally maintained objects than with remote objects.

1.1.3.2. Communication Patterns

Communication patterns provide the only link of a component to its external world. They define the
semanticsand policy of communication. By using afixed set of communication patterns, the semantics
of the services of a component is predefined, irrespective of where the communication patterns are
applied. By knowing the communication pattern, the semantics and policy of this particular service of
the component is known. This supports and enables separation of roles (system integrator can rely on
the known pattern) and system composition (services become exchangeable) where new applications
can be composed by reusing aready existing software building blocks.

Patterns for communication

Send Client/server One-way communication
Query Client/server Two-way request/response
Push newest Publisher/subscriber 1-to-n distribution

Push timed Publisher/subscriber 1-to-n distribution

Patterns for component coordination and configuration

Event Client/server Asynchronous conditioned notification
Parameter Master/slave Run-time configuration

State Master/slave Lifecycle management and activation
Dynamic wiring Master/slave Dynamic connection wiring
Monitoring Master/slave Run-time monitoring of components

Figure 1.2. Available communication patterns.
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1.2. Resources

1.2.1.

1.2.2.

Online Resources

» Website of Service Robotics Ulm [http://www.servicerobotik-ulm.de]
» SmartSoft/ACE documentation [http://www.servicerobotik-ulm.de/drupal/doxygen/aceSmartSoft/]

e SmartSoft and SmartMDSD Toolchain  download [http://www.servicerobotik-ulm.de/dru-
pal/?g=node/63]

» Documentation of availabl e ready-to-use SmartSoft components and communi cation objects [ http://
www.servicerobotik-ulm.de/drupal/doxygen/components_commrep/]

* Youtube channel: demos and tutorials [https.//www.youtube.com/user/Roboti csAtHsUImM]

Further Reading

The following reading resources are recommended in order to understand SmartSoft and its ser-
vice-oriented component way of thinking as well as the SmartMDSD Toolchain.

* "Model-Driven Software Development in Robotics: Communication Patterns as Key for aRobotics
Component Model" [1]

» "Model-Driven Software Systems Engineering in Raobotics: Covering the Complete Life-Cycle of
aRobot" [2]

» "Service Robot Control Architectures for Flexible and Robust Real-World Task Execution; Best
Practices and Patterns' [3]

* "The SmartMDSD Toolchain: An Integrated MDSD Workflow and Integrated Devel opment Envi-
ronment (IDE) for Robotics Software" [4].

This is the most complete publication about the SmartMDSD Toolchain. It describes all links and
steps within the SmartMDSD Toolchain.

« A complete list of publications is available at http://www.servicerobotik-ulm.de/dru-
pal/?g=node/15.
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Chapter 2. Using the SmartMDSD
Toolchain

2.1. Introduction

2.1.1.

2.1.2.

2.1.3.

The SmartMDSD Toolchain is based on Eclipse Modeling Tools and uses graphical and textual Do-
main Specific Languages (DSLs). It uses UML-profiles to implement the SmartSoft robotics meta-
model SmartMARS and uses PapyrusUML for graphical modeling. Xtext is used for textual model-
ing. Additional assistants, validators, checks and glue-logic create the necessary bridges between the
DSLsto achieve the overall workflow. Using other Eclipse plugins, e.g. CDT, the component devel-
oper can add business logic to the component and implement, for example, algorithms, glue code or
reuse libraries. [4]

Installation and Requirements

For running SmartSoft, you need the SmartSoft kernel and ACE. We recommend the script-based
installation as described on the website [ http://servicerobotik-ulm.de/drupal/2g=node/34].

To run the SmartMDSD Toolchain we recommend Ubuntu 12.04 LTS and Java OpenJDK 1.6.0_36.
A minimum of 4GB RAM is required if you only use few components, but we recommend 6-8GB
+ for large setups.

We recommend to install the latest version of the SmartM DSD Toolchain using the installation script.
If you prefer to install it manually, follow these instructions:

# wget http://sourceforge. net/projects/smart-robotics/files/|latest/
downl oad?sour ce=di rectory
# tar -xzf Smart MDSD-t ool chai n-X. X tag. gz

You can start the toolchain by double clicking the extracted binary "SmartM DSD-toolchain-X.X/
eclipse" (prefered/standard method).

Development Workflow

The development workflow is divided in modeling communication objects, modeling and implement-
ing components and then using these components to integrate them by composition. The rest of this
chapter follows this structure. For a complete description of the development workflow, please refer
to[4].

Working with the SmartMDSD Toolchain and

SmartSoft Framework

2.1.3.1. SmartMDSD and SmartSoft on the filesystem

After the script installation ACE isinstalled at $ACE_ROOT (typically / opt / ACE_wr apper s) and
SmartSoft is installed at $SMART _ROOT_ACE (typicaly $HOVE/ SOFTWARE/ smar t sof t ). Ex-
isting SmartMDSD projects can be found at:

* SmartSoft communication/coordination projects: $SMART_ROOT_ACE/ src/interface-
Cl asses/

* SmartSoft component projects: $SMART _ROOT_ACE/ sr ¢/ conponent s/
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» SmartSoft deployment projects: $SMART _ROOT_ACE/ sr ¢/ depl oyment s/

The most convenient place to keep new SmartSoft communication/coordination projectsisin the di-
rectories listed above. If you would like to store SmartSoft communication/coordination projects on
an other directory add the following line to your ~/.profilefile:

export SMART_PACKAGE_PATH=$SMART_PACKAGE_PATH: <EXTERNALDI RECTCRY>

Thereby, <EXTERNALDIRECTORY > has to be replaced with the directory to the SmartSoft com-
munication/coordination project.

For technical reasons at the moment, you cannot have SmartSoft projects in a directory-tree that
leads to other SmartSoft projects. In other words, do not keep a SmartSoft project in a direct hi-
erarchy of another project. Example: it is not allowed to have a SmartSoft Component project at
~/SOFTWARE/smartsoft/, because there are other projects in ~/SOFTWARE/smartsoft/src/compo-
nents/. However, you arefineto keep your custom projectsin~/my_projects/ or ~/SOFTWARE/smart-
soft/src/my_components/ or even ~/SOFTWA RE/smartsoft/src/components/. For most cases, e.g. if
you are using version control, you will not encounter this problem.

2.1.3.2. Starting the SmartMDSD Toolchain for the First Time

This section will give first time toolchain users an manual on how to set-up the toolchain efficiently.

Start the toolchain by double-clicking the eclipse-executable (recommended) or executing . /
ecl i pse inatermina withinthe directory it has been extracted to. The toolchain will need read and
write permissionsto all imported eclipse projects, therefore we recommend to start the toolchain with
the same user that has checked out the SmartSoft repository / installed SmartSoft.

During start-up the tool chain splash will be displayed stating the version of thetoolchain. Asisnormal
for eclipse, the user is asked to select a workspace containing projects and settings. How to organize
different workspaces is completely up to the user, in case you have no experience with Eclipse we
recommend to keep the multiple workspaces concentrated in one directory e.g. ~/ WORKSPACES.

Starting the toolchain for the first time, a new workspace location could for example be: / hone/
$SUSERNAME/ WORKSPACES/ Snar t MDSD_v2. 10. New directorieswill be created if necessary.

x
- — )
SmartMDSD Toolchain EE Service Robotles Ulm | Select a workspace
Version 2.10 R amous oD st e Eclipse stores your projects in a folder called a workspace.

Choose a workspace folder to use for this session.

Workspace: |/home/username/WORKSPACES/SmartMDSD_v2.10 v Browse...

Use this as the default and do not ask again

Cancel | | oK | |

Figure 2.1. Start toolchain and select new wor kspace

Once the toolchain is completely started and a new empty workspace has been created the "Welcome
to the Eclipse Modeling Tools" window will be shown. Closing this inner window will set up the
standard (java) eclipse interface.
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Figure 2.2. Start toolchain and select new workspace

Eclipse features dedicated window arrangements called perspectives to support different task. The
toolchain has its own perspective "SmartSoft". To use this perspective select in menu: W n-
dow >Qpen Perspective->Qher... Smart Soft

Open Perspective

[zm CVS Repository Exploring -
%5 Debug

& Ecore

[&r Git Repository Exploring

& Java (default)

$J Java Browsing

T2 Java Type Hierarchy

~J Papyrus

@ Planning

4= Plug-in Development

= Property view Customization
[?5 Resource

(= SmarkSoft

&" Team Synchronizing

| Cancel |[ ~ OKN J
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Figure 2.3. Select the SmartSoft perspective to set-up up eclipse for efficient
SmartSoft modelling use.

Some tool chain projects make use of automatically triggered code generation, thereforeit is necessary
that eclipse is configured to build the projects in the workspace automatically. This setting is enabled
by default, to ensure this the user can revisit the setting in the menu: Pr oj ect - >Bui | d Aut o-
matically
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Emart5oft - Eclipse

Q B e | [ smartsalt
L Project | % Hawvdgat = O = o
= e -
I ha [ = o EPereperties 5[ s T o=
B Y
M el Avallable Praperties are nok availssle

aitems selected

Figure 2.4. The started SmartM DSD toolchain.

Given this few steps the toolchain is ready to use. To make use of existing work (components, Com-
municationObjects, deployments, etc.) afirst step isto import those projects the user wants to reuse,
into the workspace.

The different kind of toolchain projects (supporting different roles) depend on each other. Communi-
cation objects are wrapped in communication/coordination repository projects, they may depend on
other projects of the same type, as communication objects can be nested. Component projects depend
on communi cation/coordination repository projects asthey are using communications objects to mod-
el the services a component features. Deployment projects depend on component projects as they are
used to model a system consisting of components.

Dependent projects, e.g. a communication/coordination repository projects required by a component
project, are not imported automatically. Therefor the user has to import all (direct and dependent)
used projects.

Since the communication objects are the fundamental building blocks, their projects are typically the
first thing to import.

To import projects into the workspace select in menu: Fi | e->1 npor t . Within the Import dia-
log select: Gener al - >Exi sting Projects into Wrkspace continue with next and se-
lect the directory containing the projectsto include e.g. / hone/ user name/ SOFTWARE/ smart -
soft/src/interfaceC asses. Eclipsewill search recursively for projects from this directory
on and will present alist of projects to import. In this example alist of all communication/coordina-
tion repository projects that are shipped within the smartsoft repo. Importing all existing communica-
tion/coordination repository projects into the workspace isin most cases a reasonable thing to do.
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Import Projects

Select a directory to search for existing Eclipse projects. EZ
@ select root directory: |/home/lutz/SOFTWARE/smartsoft/src/interfaceClasses Browse... |\
Select archive file:
Projects:
@ CommAdaptationObjects (/home/lutz/SOFTV la C Objects) Select All
@ CommAppObjects (/home/lutz/SOFTWARE/smartsoft/src/interfaceClasses/CommAppObjects) —
@ CommBasicObjects (/homey/lutz/SOFT lasses/CommBasicObjects) eseled
@ CommElevatorObjects (/home/lutz/SOF lasses/C Objects) Refresh
@ CommF tionObject: OF interfaceClasses/CommpF. o
commForkliftobjects (/home/lutz/SOFTWARE/smartsoft/src/interfaceClasses/CommForkliftObjects)
tionObject: oF rfaceClasses/CommG ogr
c utdoor Object: ¢/interfaceClasses/CommindoorO
fDObjects OF i la: C fDObjects)
@ CommLaserObsta /interfaceClasses/CommLaserObstz
@ CommLot Objects (/home/lutz/SOF interfaceClasses/CommLocalizationObjects)
@ CommManipulationPlannerObjects (/home/lutz/SOF interfaceClasses/Ct
@ CommManipulatorobjects (/home/lutz/SOFTV interfaceClasses/C Objects)
@ C Objects (/home;/lutz/SOFTV interfaceClasses/C nObjects)
@ CommoObjectRecognitionObjects (/home;/lutz/SOFTWARE/smartsoft/src/interfaceClasses/CommObjectRecogniti
[ Copy projects into workspace
Working sets
Add project to working sets
@ <Back cancel Finish

Figure 2.5. Import projects into the workspace, in this case communication/
coordination repository projects proj ects.

Once imported the tool chain starts building the projects (reading files and generating code in case the
models have changed). The progress can be seen at the bottom right task bar of the toolchain. Other
activities such as the C++ indexer for example are also displayed there.

It isimportant to note that building in this context is always related to eclipse projects and the models,
not to the generated results (e.g. C++ code) so no C++ compiler will be triggered.

SmartSoft - Eclipse

File Edit Navigate Search Project Run Window Help

o SR G E Q = & Java (3 smartsoft
[ Project Explorer 58 | % Navigator = = g
B %

» =¥ CommAdaptationObjects

» % commAppObjects

» 1% CommBasicObjects

» ¥ CommeElevatorObjects

» &% CommFaceRecognitionObjects

» % commForkliftobjects

» & CommGestureRecognitionObjects

» ¥ CommindooroutdoorNavigationObjects
» % CommKatanaL fDObjects

» &5 CommLaserObstacleAvoidRepository
» ¥ CommLocalizationObjects

» & commManipulationPlannerobjects

» % CommmManipulatorobjects

+ & CommNavigationObjects

» 1% CommoObjectRecognitionObjects

» % CommPersonDetectionObjects

B Model Ex % [k == 5 El properties 5 [+

® Y =0

No Model Available Properties are not available.

Oitems selected : Building workspace: (80%) T E

Figure2.6. Toolchain with imported communication objectsrepository projects.

For components or deployment projects the same import procedure can be applied. How to use the
imported projects and how to build new projects will be explained in the subsequent sections.

2.1.3.3. SmartMDSD Eclipse Projects

Communication objects, components and system configurations are Eclipse projects. The projects
contain amodel and source code which is generated from the model by a code generator. During code
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generation, filesfor generated code and handwritten code are created (using the generation-gap pattern
which links user-code and generated-code by inheritance). The src-gen folder contains the generated
code. These files must not be changed by the user, because they are regenerated each time the code
generator is started. Therefore, changes to these files will be lost. Files for handwritten code are lo-
cated in the src-folder. These files are generated once and provides method skeletons for user imple-
mentation. However, this means that the files have to be adjusted/deleted manually after renaming/
deleting the corresponding model element.

For automatic code generation and caching, make sure autobild is activated in the workspace. For that,
choose Project->Build Automatically in eclipse. If autobild is enalbed, acheck mark isshownin front
of the menu entry "Build Automatically”.

2.1.3.4. Version Control Considerations

All folders and files of the projects except the folders "bin" and "build" should be commited. These
folders contain files which are altered as soon as the project is opened in the toolchain. Therefore, it
is not advisable to add these folders to the version control.

2.2. System Design View

2.2.1.

The system design view is used to prepare the communication objects that components use for in-
teracting with others through services. Communication objects are grouped to communication ob-
ject repositories, that name a group of communication objects. To create a new communication/co-
ordination repository project, select "File->New->SmartSoft Communication/Coordination Reposi-
tory" (cf. figure 2.7), enter a name and choose a storage location. Typically the project is stored at
"$SMART_ROOT_ACE/src/interfaceClasses' and itsname startswith " Comm" followed by the name
of the repository.

@™ smartSoft - Eclipse

File Edit Navigate Search Project Run Window Help

=
OpenFile... [ SmartSoft Component
SmartSoft Deployment
Close All £ Project...
4 Example...

r4 Other...

™ Rename...
&] Refresh
Convert Line Delimiters To

switchworkspace
Restart

&3 Import...
&4 Export...

Properties

Exit

Figure 2.7. Create a new Communication/Coordination Project

Existing SmartSoft communication/coordination projects can be imported by selecting "File->Im-
port". In the appearing dial og choose " General ->Existing Projectsinto Workspace”. See section " Start-
ing for the first time" for more information.

The created project containstwo different models. A communication objects model (file *.comm) and
a Parameters model (file * .pardef). These models are located in the model-folder of the project.

Project Structure

Communication/coordination projects contain various folders and files. For the devel opment of com-
munication objects and parameters the following are important:
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« build: Directory for compiling source code using cmake. This directory should not be versioned.

 bin: Temporary, toolchain internal folder. This directory should not be versioned.

model: The model folder contains the textual models of the communi cation objects and parameters.

src: After the code generation this folder contains user-specific source code for custom user-func-
tions. For advanced usersonly (e.g. if you want to implement custom and complex access methods).

e src-gen: The src-gen folder contains source-code that is generated by the SmartSoftMDSD tool-
chain. Please do not modify these files, they will be overwritten each time the toolchain generator
isrun.

CMakel ists.txt: Thisfileisused to changethe default cmake behavior or to add additional libraries
and dependencies. Further information is provided in section 2.3.4.

%5 Project Explorer & | == Navigator

¥ 1% CommBasicObjects
» =i JRE System Library [JavaSE-1.6]
> i model
E) Plug-in Dependencies
> 4P Binaries
* &l Includes
> &= bin
> = build
» = debian
¥ = META-INF
> ;= model
= src
P = src-gen
> & build
> = debian
> = META-INF
> = model
» Esrc
> (= src-gen
CommBasicObjectsConfig.cmake.in
mb build.properties
[El CMakelLisks.kxt

Figure 2.8. Structur e of communication/coor dination projects

2.2.2. Communication Objects

Communication objects parameterize the communication patterns and are transmitted by value. The
following sections describes how communi cation obj ects are model ed and implemented. Additionally,
a screencast which demonstrates the modeling of communication objectsis available in section 3.1.1.

2.2.2.1. Modeling Communication Objects

Communication objects are modeled in a SmartSoft communication/coordination repository project.
The model has the file extension " .comm' and is located in the folder model/commObject. An empty
model is generated once, after you created the project.

10
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SmartSoft - CommBasicObjects/mot imObject/CommBasicObjects.comm - Eclipse

File Edit Navigate Search Project Run V Help
i 7% P v Q B & Java [y smartsoft| 72 Papyrus
 Project Explorer 5 | % Navigator = B | i commBasicobjects.comm % =8

=4

¥ 555 CommBasicobjects
> = JRE System Library [JovaSE-1.6
> ® model

=i Plugin Dependencies 2
» 4 Binaries 30 ConmobjectRepository ConmBasicobjects Version 1.0.0 {
" 3 mmobject ComnVoid {

includes dunmy: Int32
> & bin EER
> = build 3 Comnobject ComBool {
35 boolValue: Boolean
> G debian EN
> & METAINF 375 Comnobject ComTimestamp {
> @ model @ 32 =
usec: UInt32 =
> @ sic 0 )
> @ sicgen 15 Commdbject ComnPosition3d {
> & build 2 o0
> & debian
> & METAINF y
¥ 2 model Comtbjact Comdrientationds {
¥ = commObject 5 elevation: Double = .0
sicob 9 roll: Double = .0
> @& parameter Comobject ComPose3d {
> @ state 52 position: CommbjectRef (ComPosition3d)
> s s =
. N [ SmartParameterEditor % =0
% Model Explore 3 . =0
o Noselection,
1 4
No Model Available
mm- bject

Figure 2.9. Model Communication Objects

The model consists of exactly one CommObjectRepository whose name must match the name of the
project name. The CommObjectRepository of the project CommBasicObjects for example has to be
defined asfollows:

Conmbj ect Reposi tory ConmBasi cObjects Version 1.0.0 {

Inside the CommObjectRepository an arbitrary number of communication objects, structs and enu-
merations can be defined.

A communication object is modeled as follows:

Commbj ect <name> {
<nane> : <data type> = <val ue>

}

The keyword ConmmObj ect is used to define a communication object. After the keyword the name
of the communication object is given. Thisname should start with a capital |etter. The elements of the
communication objects are enclosed by curly braces. They consist of a name which should start with
asmall letter and a data type which can be optionally assigned with adefault value. If no default value
should be assigned, the assignment "= <value>" must be omitted. Possible data types are:

* Boolean

» CommObjectRef
» Double

* EnumRef

* Float

e Int8, Int16, Int32, Int64

11
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 String
» StructRef
» UInt8, UInt16, UInt32, UInt64

Furthermore it is possible to use lists of these data types. In order to do so, an opening and closing
square bracket has to be written behind the data type. The sguare brackets enclose the number of
elements of thelist. If the size of the list should be variable the symbol *' is used.

If, for example, the velocity and rotation angle of a robot should be transmitted, the corresponding
communication object can be defined as follows:

ConmmObj ect CommNavi gati onVel ocity {

vX: Double = .0
vY: Double = .0
onega: Double = .0
}

This example can be found in the CommBasicObjects repository. The name of the communication
object isCommNavigationVel ocity and it containsthe attributesvX, vY and omega. All these attributes
are of the data type Double and have the default value 0.0. The attribute vX specifies the velocity
towards x and the attribute vY specifiesthe velocity towardsy. The attribute omegais used to specify
the rotation angle of the robot.

Lists are defined as follows:

Comm®bj ect CommPer sonDet ecti onEvent Resul t {
environnent _id: Unt32=0
person_id: U nt32[*]

}

In this exampl e the attribute person_id of the communication object CommPer sonDetectionEventRe-
sult isalist of any number of UInt32 values.

Additionally to the simple data typesit is possible to use EnumRef, StructRef and CommObjectRef.
These are references to Enums, Structs or communication objects. To be able to use such a data type
the referenced Enum, Struct or communication object has to be defined inside the model. If an Enum,
Struct or communication object of another SmartSoft communication/coordination repository should
be referenced, the repository has to be imported by using the keyword 'ImportUri'. To import for
exampl e the CommBasi cObjects repository the following line has to be added at the beginning of the
model:

I mportUri "platform/resource/ ConmBasi cObj ect s/ nodel / conmObj ect/
ConmBasi cObj ect s. commt’

Structs are defined with the keyword 'Struct'. After the keyword the name of the Struct is given. The
attributes of the Struct are enclosed by curly braces. They consist of a name which should start with
asmall letter and a data type. Optionally a value can be assigned to the attribute. If no default value
should be assigned, the assignment "= <vaue>" must be omitted. The data types are the same asin
the communication object except of the datatype CommObjectRef. This data type should not be used
in Structs.

Struct <name> {

12
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<nanme> : <data type> = <val ue>

}

Enumerations are defined with the keyword 'Enum'. After the keyword the name of the enumeration
is given. The elements of the enumeration are enclosed by curly braces and consist of a name.

Enum <name> {
<nane>

}

An attribute which references an Enum can be defined as follows:

Enum Conpari sonState {
UNKNOMN
GREATER
LOVER
| NBETWEEN

}

Comm®bj ect ConmBatteryEvent {
chargeVal ue: Double = .0
state: EnunRef (Conpari sonSt at e)

}

This example can be found in the CommBasi cObject repository. The enumeration contains four items
which specify the used comparison state. Inside the communication object CormBat t er yEvent
this enumeration isreferenced. This meansthat the attribute st at e is of the data type ComparisonS-
tate. For referencing, it makes no difference whether the enumeration is defined before or after the
communication object.

An example for referencing communication objects can be found in the CommBasicObjects reposi-
tory:

ConmmObj ect Commli neSt anp {
sec: Unt32 =0
usec: Unt32 =0

}

CommObj ect CommDat aFi |l e {

filenane : String

filesize : U nt32

ti mestanmp : ConmObj ect Ref (Commi neSt anp)
data : Int8[*]

valid : Bool ean

}

The communication object CommDatakFile contains an attribute timestamp which is of the data type
CommTimeStamp.

2.2.2.2. Generated files

Thecodegenerator will start assoon asthe model of the SmartSoft communi cation/coordination repos-
itory issaved. The code generator creates C++ code for all communication objects of the repository. If

13
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2.2.3.

acommunication object is deleted from the model, the corresponding files inside the src-folder have
to be deleted manually. Otherwise the repository will not compile.

The following files are generated into the src-folder:
e <commObj name>.cc
» <commObj name>.hh

Standard getter and setter methods are generated automatically. If you need more advanced access
methods, you can proceed as follows: In the <commObj name>.cc and <commObj name>.hh files
methods of the communication object can be adjusted or added. For exampl ethe getter and setter meth-
ods of the communication object ConmNavi gat i onVel oci t y were adjusted as follows (Comm-
BasicObj ects/src/CommBasi cObjects’CommNavigationV el ocity.hh):

i nl i ne doubl e get_vX(const doubl e unit
getVX() * (0.001 / wunit); }
i nl i ne doubl e get_vY(const double unit
getVyY() * (0.001 / wunit); }

0.001) const { return

0.001) const { return

inline void set_vX(double v, const double unit
* (1000 * wunit) ); }
inline void set_vY(double v, const double unit
* (1000 * wunit) ); }

0.001) { setVX( v

0.001) { setVY( v

These methods are used to return and set the trandation velocity in various units. The default unit is
millimeters per second.

mBasicobject: INavigationVelocity.hh - Eclipse

or Navigate Search

G v Q B & Java |[y Smartsoft| 72 Papyrus

& Project Explorer 2 | % Navigator = O | B CommNavigationVelocity.hh 5t =g
6 #deTine COMMEASICUBJECIS COMMNAVIGATIONVELOCITY H_

v 5 Commensicobects 8 #include "ComBasicObjects/ConnNavigationvelocityCore. hh

> i JRE System Library [JavaSE-1.6 60 namespace ComBasicobjects {
> @ model ¢
62 class ComtavigationVelocity : public CommNavigationVelocityCore {
i Plugin Dependencies & pubtics
> 42 Binaries s // default constructors
> i Includes 6 ati
66
> & bin 6
> & build b
> = debian
¥ & CommBasicobjects
* [@ CommBasePose.cc onst doubl
> [ CommBasePose.hh CommNavigationVelocity (const CommliavigationVelocityCore &comnNavigationvelocity);
> 5 CommBasePositionUpdate.cc igati i DATATYPE
» [ CommBasepositionUpdate.hh virtual ~ComNavigationvelocity();
> [3 Commaasestate.cc 8 se franewo getter and setter methods fron core (base) class
> (B CommBasestate.nh 83 using ComNavigationvelocityCore: :get;
> [ CommBaseVelocity.cc 8 using ComiavigationVelocityCore: :set;
> [ CommBaseVelocity.hh e p
> [ CommBatteryEvent.cc SI 77 feel free to add customized methods here
% Model Explore 12 P - Get the translation velocity in units of \a unit meters per second
. Default unit is millineters per second
v @ o
o Model Avaliable inline double get_vX(const double unit = 0.001) const { return getvk() * (6.601 / unit); }
inline dauhla aet uyicanct dauhla unit = o AA1) canct I return ne UV() (0 AM / unit) )
L SmartParametertditor 3 = a
Noselection.
8/ BasicObjects/Cc

Figure 2.10. Add custom functions

Parameter Sets

In addition to the following description a screencast of modeling Parameter sets is shown in section
312

Parameter setsare modeled in a SmartSoft communi cation/coordination repository project. The model
hasthe file extension *.pardef' and islocated in the folder model/parameter. It consists of exactly one
Par amReposi t or y which contains an arbitrary number of parameter sets.
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mBasicObjects/mo

meter/BasicParams.pardef - Eclipse
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. 35 Trigger SIGNAL STATE ERROR ()
@ METAINF 36 Trigger SIGNAL STATE BUSY

> 5 model 37

Trigger SIGNAL STATE LOCALIZATION ERROR {}
> Gosic 38 Trigger SIGNAL STATE SAFETY_FIELD {}
> @ sicgen ’

> & build Paranset WebInterfaceParans {
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@ state 50 | Petlavclientservicetare:string
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5

No Model Available » Trigger COPYFILE {
9 sourceFile : String

L SmartParameterEditor 3
No selection.

BasicParams.pardef - CommBasicobjects/model/parameter

Figure 2.11. Model Parameter Sets

The ParamRepository of the project CommNavigationObjects for example is defined as follows:

Par amReposi t ory ConmNavi gati onCbj ects {

The definition of a parameter set starts with the keyword 'ParamSet' and is followed by a name.

Par anset <name> {

Inside the parameter set parameters and trigger can be defined. These are enclosed by curly braces.

A parameter is defined as follows:

Par am <name> {
<nane> : <data type>

}

The keyword 'Param'’ is used to define a parameter. After the keyword the name of the parameter is

given. The elements of the parameter are enclosed by curly braces and consist of a name and a data
type. Possible data types are:

* Boolean
* Double
 Enum

» Float

15
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* Int8, Int16, Int32, Int64

 String

» UInt8, UInt16, UInt32, UInt64

Furthermore it is possible to use lists of these data types. In order to do so, an opening and closing
square bracket has to be written behind the data type. The sguare brackets enclose the number of
elements of thelist. If the size of thelist should be variable the symbol *' is used.

A Trigger is defined as follows:

Trigger <nane> {
<nanme> : <data type>

}

Trigger are defined with the keyword 'Trigger'. After the keyword the name of the trigger is given.
The elements of the trigger are enclosed by curly braces and consist of a name and a data type. The
data types are the same as in the parameter definition.

The following example of a parameter set definition can be found in the CommNavigationObjects

repository.

Par anSet Mapper Par anms {
Tri gger CURPARAMETER {

Xsize : Int32
ysize : Int32
Xpos : Int32
ypos : Int32
id: Int32

}

Par am CURLTM {
preoccupation : Enum { DI SABLE ENABLE }
threshold : Int32

}
}

Inthisexamplethetrigger CURPARANMETERis defined inside the parameter set Mapper Par ans and
contains the elements xsize, ysize, xpos, ypos and id. The parameter CURL TMcontains the elements
preoccupation and threshold.

2.2.4. Compile SmartSoft Communication/Coordination
Repositories

To be able to use the the communication object during the component devel opment they have to be
compiled. To do so, right click on the repository and choose "Compile SmartMDSD Project” (cf.
figure 2.12).
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2.2.5.

[ SmartSoft - Eclipse
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Figure 2.12. Compile a communication/coor dination project

If the communication/coordination project has to be compiled without the toolchain, navigate to the

repository and enter the following commands:;

nkdir build
cd build
cnmake

make

Documentation

For communication objects, structs and enumerations a *.dox file is generated automatically as soon
asthemodel is saved. Thisfile can be used to generate a documentation with doxygen. The documen-
tation contains all communication objects, structs and enumerations of the CommObjectRepository
with their names, attributes and a class reference. To add further information to the class reference the
'‘@doc' keyword followed by a String has to be written on top of the communication object, struct or
enumeration. The information will then be included in the documentation.

3 [Z) commBasicObjects.comm 2
31= CommObjectRepository CommBasicOobjects Version 1.0.0 {

@doc "Communication Object to command the robot”
34 CommObject CommNavigationVelocity {
35
6 @doc "Speed in x direction [m/s]"

37 vX: Double = 0.0

39 @doc "speed in y direction [m/s]"
40 vY: Double = 0.0

a1

42 @doc "Rotation speed [rad/s]"

43 omega: Double = 0.0

44 ¥

Figure 2.13. Documentation of communication objects

2.3. Component Development View

The component development is also shown in a screencast (section 3.1.3).
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2.3.1.

For the component development a new SmartSoft component project has to be created. To do so,
choose "File->New->SmartSoft Component"” (cf. figure 2.14), enter a name and choose a storage lo-
cation. Typically the project isstored at "$SMART_ROOT_ACE/src/components” and its name starts
with "Smart" followed by the purpose of the component.

° SmartSoft - Eclipse

File Edit Navigate Search Project Run Window Help

1 SmartSoft Communication/Coordination Repository
OpenFile... =
{a SmartSoft Deployment
4 Project...

close All
£ Example...

9 Other...

&1 Refresh
Convert Line Delimiters To

switch Workspace
Restart

& Import...
&4 Export...

Properties

1BasicParams.pardef [CommBasicObject...]

2 CommPersonDetectionObjects.comm [Co..]
3 CommObjectRecognitionObjects.comm [..]
4 CommNavigationObjects.comm [CommNav..]

Figure 2.14. Create a new component project

Existing SmartSoft component projects can be imported by selecting "File->Import". In the appearing
dialog choose " General->Existing Projects into Workspace'.

The development of SmartSoft components consists of two steps. The component modeling and the
component implementation. During the component modeling the external structure of the component
is defined. The services which are used to communicate with other SmartSoft components, as well
as the parameters which can be adjusted during the system composition are defined during this step.
After the external structure is modeled, the code generator has to be started manually. The generated
C++ files are used to implement the functionality of the component.

Component Projects

Component projects have a common folder structure as explained in the following:
* build: Thisdirectory contains the cmake generated files and should not be versioned.
* bin: Temporary, toolchain internal folder. This directory should not be versioned.

» model: The model folder contains the graphical model of the Component (*.di) and the human
readable documentation model of the component (<component name>_documentati on.compdoc).

» grc: Thisfolder contains of both, the initially generated C++ files and the custom C++ files. The
generated C++ files in this folder will not be overwritten during the successive code egenerator
calls and thus can be safely modified according to the component's specific needs.

» src-gen: Source-code that is generated by the SmartSoftMDSD toolchain. Please do not modify
thesefiles, they will be overwritten each time the toolchain generator is executed.

» CMakeliststxt: Thisfileisused to include additional sourcesfor compilation and add external li-
braries or further smartsoft utilities and/or communi cation-objects. (Further information is provided
in section 2.3.4)
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Figure 2.15. Structure of Component Projects

2.3.2. Component Modeling
The Component model is part of a SmartSoft Component project and is located in the model-folder.

2.3.2.1. Component Hull

The component hull is modeled graphically. The model consists of a component which provides and
requires servicesin order to interact with other components and contains tasks, timers and parameters
to implement a specific functionality. The various elements of the component are displayed in the tool
palette of the SmartMDSD Toolchain. In order to add an element to the component, the element hasto
be selected in the tool palette and then to be added to the component-diagram by clicking into it. The
properties of the various elements can be adjusted in the propertiestab if the element is selected in the
model. To delete amodel element right click on the element and choose "Delete Selected Element”.
Do not use the delete key on your keyboard to delete model elements. Due to a double assignment of
the delete key the elements may be hidden instead of deleted. Figure 2.16 illustrates the modeling of
the component hull with the SmartMDSD Tool chain.
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Figure 2.16. Modeling Component Hull
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2.3.2.1.1. Communication Patterns

Communication patterns define how SmartSoft components communi cate with each other. They con-
sist of two complementary parts named service reguestor and service provider representing a client/
server (e.g. PushNewestClient/PushNewestServer), or, master/dave (e.g. StateMaster/StateSlave) re-
lationship. The various communication patterns are described in section 1.1.3.2. To model a service
requestor or service provider add acommunication port and, where necessary, a handler to the mode.
Todo so, select theelement in thetool pal ette and click on the component. Afterwards, adjust the prop-
erties of the port or handler in the propertiestab. Thefollowing list presentsthe individual properties:

event:
e SmartEventServer:

« eventSate: Defines the communication object of the event state, which is used by the
SmartEventTestHandler (see below) to check the event parameter.

+ smartEventTestHandler: Defines the SmartEventTestHandler which is used to check wether an
event fires according to the client-specific eventParameter (see next).

« eventParameter: A client registers to an EventServer with an event activation parameter. The
eventParameter defines the communication object of this event activation parameter to be used
within the SmartEventTestHandler (above). The communication object must match the commu-
nication object of the eventParameter of the SmartEventClient (see below).

« eventResult: Specifies the communication object of the event result, which is the actually com-
municated event with according data-payload.

e SmartEventClient:

» smartEventHandler: Defines the SmartEventHandler which is used as a callback-handler to re-
ceive the event results.

« serverName: Specifies the name of the component that provides the event result. (Thisvaueis
refined during system configuration (see section 2.4.2) and can therefore be left blank.)

« wireable: Defines whether or not the port can be wired dynamically (using the Wiring pattern).

» serviceName: Specifies the name of the SmartEventServer. (This value is also refined during
system configuration (see section 2.4.2) and can therefore be left blank.)

» eventParameter: Defines the communication object of the event parameter. The client registers
with an event parameter to the SmartEventServer in order to parametrise the server-side event-
filter (implemented inside of the according SmartEventTestHandler in the server). Thisalowsto
specify events of interest and reduces unnecessary communication overhead.

» eventResult: Specifies the communication object of the event result.
push timed:

e SmartPushTimedHandler: is a call-back handler used by SmartPushTimedServer to periodically
publish updates.

* isActive: Specifieswhether the SmartPushTimedHandler is active or passive. If the handler is set
passive, the processing of incoming requestsis driven by the upcalling thread of the SmartPush-
TimedServer. A passive handler should avoid using blocking system-calls (such as e.g. sleeps,
waits, smeaphores, condition variables, etc.).

* SmartPushTimedServer:

 timeUnit: Specifies the time unit of the cycle decorator (s, ms, us or ns).
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cycle: Specifesthetimeinterval at which new datais provided.

smartPushTimedHandler: Specifies the SmartPushTimedHandler which is used to periodically
send data

commObject: Specifies the communication object which is send to aclient.

¢ SmartPushTimedClient:

interval: It is possible to get every n-th update to reduce unnecessary communication overhead.
The prescaler of the server cycleis specified with this parameter.

serverName: Specifiesthe name of the component which providesthe data. (Thisvalueisrefined
during system configuration (see section 2.4.2) and can therefore be left blank.)

wireable: Defines whether or not the port can be wired dynamically (using the wiring pattern).

serviceName: Specifiesthe name of the SmartPushTimedServer. (Thisvalueisalso refined during
system configuration (see section 2.4.2) and can therefore be left blank.)

commObject: Specifies the received Communication Object. The communication object must
match the communication object which is send via the SmartPushTimedServer.

push newest:

* SmartPushNewestServer:

commObject: Specifies the communication object which is published to all subscribed clients.

* SmartPushNewestClient:

server Name: Specifiesthe name of the component which providesthe data. (Thisvalueisrefined
during System Configuration (see section 2.4.2) and can therefore be left blank.)

wireable: Defines whether or not the port can be wired dynamically (using the Wiring pattern).

serviceName: Specifiesthe name of the SmartPushNewestServer. (Thisvalueisalso refined dur-
ing system configuration (see section 2.4.2) and can therefore be left blank.)

commObject: Specifies the received communication object. The communication object must
match the communication object which is published from the SmartPushNewestServer.

query:

» SmartQueryHandler: is a callback handler used by SmartQueryServer to process incomming
queries.

L]

isActive: Specifies whether the SmartQueryHandler is active or passive. If the handler is set
passive, the processing of incoming requests is driven by the upcalling thread of the Smart-
QueryServer and thus should avoid any blocking calls.

¢ SmartQueryServer:

smartQueryHandler: Specifies the upcall-handler reference (SmartQueryHandler, see above) to
process incomming query requests.

commRequestObject: Specifies the request communication object.

commAnswer Object: Specifies the response communication object.

» SmartQueryClient:
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» serverName: Specifies the name of the component which provides the according QueryServer.
(This value is refined during system configuration (see section 2.4.2) and can therefore be left
blank.)

« wireable: Defines whether or not the port can be wired dynamically (using the Wiring pattern).

» serviceName: Specifies the name of the SmartQueryServer. (This value is also refined during
System Configuration (see section 2.4.2) and can therefore be left blank.)

» commRequestObject: Specifies the communication object of the request.
» commAnswer Object: Specifies the communication object of the response.
send:
e SmartSendHandler: is a callback handler used by SmartSendServer to process incomming sends.
* isActive; Specifies whether the SmartSendHandler is active or passive. If the handler is set pas-
sive, the processing of incoming requestsis driven by the upcalling thread of the SmartSendServ-
er and thus should avoid any blocking calls.

* SmartSendServer:

» smartSendHandler: Specifiesthe smartSendHandler which isimplementsthe callback to receive
and to process incoming data.

» commObject: Specifies the communication object of the received data.
* SmartSendClient:

» serverName: Specifies the name of the component which receives the send data. (Thisvalueis
refined during system configuration (see section 2.4.2) and can therefore be left blank.)

« wireable: Defines whether or not the port can be wired dynamically (using the Wiring pattern).

» serviceName: Specifies the name of the SmartSendServer. (This value is aso refined during
system configuration (see section 2.4.2) and can therefore be left blank.)

» commObject: Specifies the communication object which is send.

Before a communication object can be assigned to a communication port, it needs to be imported (if
not already done). Therefore, right click anywhereinside of the component diagram and select "Import
Communication/Coordination Objects”. In the next dialog, select the required communication objects
and press the OK Button. After the communication object was imported, select the communication
port and add the communication object (as shown in figure figure 2.17).
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Figure 2.17. Select Communication object

In order to assign a handler to a communication port, the corresponding handler has to be modeled in
the component model first (using the tool palette). After that, select the handler parameter in the com-
munication port and pressthe"..."-Button on the right. In the next dialog select the handler (<compo-
nent name> -> <component name> -> nestedClassifier -> <handler>) and press the OK button (cf.
figure 2.18).
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Figure 2.18. Select handler
2.3.2.1.2. SmartTask

The following settings can be made:
« timeUnit: Specifiesthe time unit of the period decorator (s, ms, us or ns).
* isPeriodic: Specifies whether or not the Task is called periodic in a specified time interval.

 period: Specifiesthetimeinterval at which thetask is called.
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2.3.2.1.3. SmartComponentMetadata

The SmartComponentM etadata has to be added to every component. It contains version and depen-
dency information.

2.3.2.2. Component Parameters

There are two main types of parameters. There are parameters to configure a component initially at
system-configuration / deployment time but not during runtime. Then there are parameters that can be
used to configure a component intially and at run-time.

Parameters can be defined within the component (component internal) and outside of the component
(component external) for reusing the definitions in multiple components. Parameters that can be set at
run-time can be defined with the keyword Ext endedPar amwithin the component or reuse existing
definitions with the keyword Par anfSet | nst ance. Parameters that can only be set initially can be
defined within the component using the keyword | nt er nal Par am They cannot be defined outside
of the component.

A component that can be configured at run-time needs a SmartParameterSlave service. A component
configuring other components does this via the SmartParameterMaster.

2.3.2.2.1. SmartParameterMaster
Provides a generic port to set configurations of components at runtime. Typically the master part is
used within the sequencer, which is in control and coordinating the system. In total one parameter
master can send parameter-sets to several Parameter Slaves. There are three different ways to use the

parameter to configure other components (which are encoded in the CommParameterRequest):

e Simple parameters such as SETPOSE(x,y) CHANGEMAP("MapName"), ... - these are name-value
configurations

 Triggers - used to trigger/start actions or activities

e« COMMIT - a specia kind of trigger that tells a component that a sequence of configurations is
complete and the component can from now on use the consistent set of new parameters.

2.3.2.2.2. SmartParameterSlave

The dave part of the parameter is used when your component is subject to configuration by other
components at run-time. The user needs at most one instance of the parameter slave per component.

2.3.2.2.3. SmartComponentParameter

The SmartComponentParameter is used to model the parameters. The elements are defined in a para-
meterDefinition. The parameterDefinition can be modified with the SmartParameterEditor which is
to the right of the properties tab. To open the parameterDefinition in the editor click on the SmartPa-
rameterEditor tab and then on the SmartComponentParameter.
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Figure 2.19. Model Component parameter
The parameters are modeled as follows:

Conponent <nane> {
<par anet er >

}

At first the component of the SmartComponentParameter is defined. The name must match the name
of the component in which the SmartComponentParameter is model ed. Inside the component internal
parameters, extended parameters, extended trigger and parameter set instantiations are defined.

Internal parameters are modeled as follows:

I nt er nal Par am <nanme> {
<name> : <data type> = <val ue>

}

Thekeyword'Internal Param'’ is used to define an internal parameter. After the keyword the name of the
internal parameter is given. This name should start with a capital letter. The attributes of the internal
parameter are enclosed by curly braces. They consist of a name and a data type. The attributes must
be assigned with a default value. Possible data types are:

» Boolean

» Double

* Enum

* Float

* Int8, Int16, Int32, Int64
 String

¢ UlInt8, UInt16, UInt32, UInt64
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Additionally, lists of these data types can be used.

If, for example, the maximum velocity and steering should be defined with parameters, the internal
parameter can be defined as follows:

I nt er nal Param setti ngs{
max_vel ocity : Doubl e
max_steering : Double

}

no
= e
N O

Extended parameters are modeled as follows:

Ext endedPar am <name> {
<nanme> : <data type> = <val ue>

}

Extended parameters are defined with the keyword 'ExtendedParam’. After the keyword the name
of the extended parameter is given. The name should start with a capital letter. The attributes of the
extended parameter are enclosed by curly braces. They consist of a name, a data type and a default
value. The possible data types are similar to the data types of internal parameters.

Extended trigger are modeled as follows:

Ext endedTri gger <name> (active| passive) {
<nanme> : <data type>

}

The keyword 'ExtendedTrigger' is used to define extended trigger. After the keyword the name of the
extended trigger followed by the keyword "active' or 'passive' is given. The attributes of the extended
trigger are enclosed by curly braces. They consist of aname and adatatype. The datatypesare similar
to the data types of internal parameters.

As mentioned before, parameters can be defined outside of the component and can be reused. For that
purpose the model of the parameter set has to be imported first:

| mport Uri <pat h>

The parameter set is then instantiated as follows:

Par anfSet | nst ance <repository>. <param set nane> {
InstantiateTrigger <trigger name> (active| passive)
I nst ant i at ePar am <par anmet er name> {

this.<attribute nane> = <val ue>

}
}

The instantiation of a parameter set is defined with the keyword 'ParamSetinstance’ followed by the
repository and name of the imported parameter set. The parameters and trigger which should be in-
stantiated are enclosed by curly braces. Trigger are instantiated with the keyword 'InstantiateTrigger'
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followed by the name of the trigger and either the keyword 'active' or ‘passive’. Parameters are instan-
tiated with the keyword ‘'InstantiateParam'’ followed by the name of the parameter and the attributes
which are enclosed by curly braces. The attributes which should be assigned with avalue are selected
with the this-operator.

An example of the instantiation of a Parameter set can be found in the component SmartCdl Server:

[mportUri "platform/resource/ ConmNavi gati onCbj ect s/ nodel /
par amet er / CommNavi gat i onQbj ect s. par def "

Conmponent Smart Cdl Server {
Par anSet | nst ance CommMNavi gati onObj ect s. Cdl Par anet er {
InstantiateTrigger SETSTRATEGY passive
I nst ant i at ePar am PATHNAVFREEBEHAVI OR{t hi s. free =
enum DEACTI VATE}
}
}

Inthisexamplethe passivetrigger SETSTRATEGY and the parameter PATHNAVFREEBEHAVIOR
are instantiated.

Please refer to the chapter of component implementation and the tutorial to see how these parameters
are used from within the component implementation.

2.3.2.2.4. Parameter Documentation

In addition attributes of parameters, extended parameters, extended trigger, instantiated parameters
and instantiated triggers can be documented. This can be donein the SmartParameterEditor by writing
the '@doc' keyword followed by a String on top of the attribute, parameter or trigger. The documen-
tation of the attributes max_velocity and max_steering of the internal parameter settings for example
can be added as follows. Use this within the parameter modeling.

/1 Parameter within the conponent
I nt er nal Param setti ngs{
@loc" Defi nes the maxi mumvelocity. This is the velocity [nls]
which will be sent when the joystick axis is at full peak.™"
max_velocity : Double = 1.0

@loc" Defines the mnimum steering angle. This is the angle [rad]
which will be sent as omega when the joystick axis is

at full peak.™"

max_steering : Double = 1.2

}

2.3.3. Component Implementation

Before implementing the component, the code generator has to be started. To do so, right click on the
component model and select "Run SmartMDSD Code Generator” (cf. figure 2.20).
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Figure 2.20. Code generation

2.3.3.1. Generated Files

Depending on the elements of the model, files are created during the code generation. For every com-
ponent thefiles

e CompHandler.cc

CompHandler.hh

* <component name>Core.cc

» <component name>Core.hh
are generated into the src-folder.

The CompHandler.* files contain code which is executed after the component is started or terminated.
By default all services, tasks and timer of the component are started in these files. Afterwards the
component is notified that the setup/initialization isfinished. The <component name>Core.* filescan
be used to declare variables and methods which should be accessible from all other files inside the
component.

For SmartTasks the following files are generated into the src-folder:
» <Task name>.cc
» <Task name>.hh

The <Task name>.* files contain a constructor, destructor and the methods on_entry(), on_execute()
and on_exit(). The method on_entry() is called once, each time the task is started and can be used to
initialize procedures. The method on_exit() is called once at the end of the thread and istypically used
to clean-up resources which were initialized in the on_entry() method. The method on_execute() is
called periodically in the thread and contains the logic of the component.

For a SmartEventClient the following files are generated into the src-folder:

» <eventHandler name>.cc
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» <eventHandler name>.hh

The <eventHandler name>.* files contain the method handleEvent(const CHS::Eventld id, const
<Communication Object> &) which is called as soon as an event is received.

For aSmartEventServer thefiles
» <eventTestHandler name>.cc
» <eventTestHandler name>.hh

are generated into the src-folder. The <eventTestHandler name>.* files contain the method
testEvent(<Communication Object> & p, <Communication Object> &r, const <Communication Ob-
ject> & s) which is used to check whether the event condition is true and the event fires. The specific
check has to be added by the user. Thereby the Communication object p is the event parameter, the
communication object r is the event result and the communication object s is the event state. If the
event condition is true the method must set the event result and return the value 'true’. In contrast, if
the event condition is false the method must return the value 'false'.

For a SmartSendServer the folowing files are generated into the src-folder:
» <sendHandler name>.cc
» <sendHandler name>.hh

The <sendHandler name>.* files contain the method handleSend(const <Communication Object>
&r) which is called as soon as a communication object is received.

For a SmartQueryServer thefiles
» <queryHandler name>.cc
e <queryHandler name>.hh

are generated into the src-folder. The <queryHandler name>.* files contain the method
handleQuery(CHS::QueryServer<<Communication Object>, <Communication Object>> & server,
const CHS::Queryldid, const <Communication Object> & request) which is called as soon as arequest
isreceived.

For a SmartPushTimedServer the following files are generated into the src-folder:
* <pushTimedHandler name>.cc
+ <pushTimedHandler name>.hh

The <pushTimedHandler name>.* files contain the method
handlePushTimer(CHS::PushTimedServer<<Communication Object>> &server) which is used to
send data periodicaly.

For a SmartStateSlave thefiles
» SmartStateChangedHandler.cc
» SmartStateChangedHandler.hh

are generated into the src-folder. The SmartStateChangedHandler.* files contain the methods
handleEnterState(const std::string & substate) which is called as soon as a substate is entered and
handleQuitState(const std::string & substate) which is called as soon as a substate is lft.

For a SmartComponentParameter thefiles
» ParameterStateStruct.cc

» ParameterStateStruct.hh
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are generated into the src-folder. The ParameterSateSruct.* files contain the method
handleCOMM I T(const Parameter StateStruct & commitState) which is used to implement consistency
checks which ensure that the incoming parameter meets internal constraints.

2.3.3.2. Start Services and Tasks

Services and tasks are connected and started in the CompHandler.cc file. By default all services and
tasks of the component are started in the method onStartup(). However, this code can be adapted to
your needs. If, for example, a component has several services, but only the specific service "imuDat-
aPushTimedClient" should be started the line

COWP- >connect AndSt art Al | Servi ces();

has to be replaced with

COWP- >connect | nubDat aPushTi nedd i ent (
COWVP- >connecti ons. i nubDat aPushTi nedd i ent . ser ver Nane,
COWVP- >connect i ons. i nuDat aPushTi nedd i ent . servi ceNane

)

Look at the generated implementation of onStartup() for more examples. Often the start of a service
should be configurable with an internal parameter. To do so, surround the start of the service with
an |IF-statement, e.g. only call COM P->connectl muDataPushTimedClient() if a specific condition is
true (cf. fig. 2.21).

The easiest way to change the code of the CompHandler is to copy the code of the default method
which containsthe startup code of all services and tasks and adjust this copied codeto your needs. The
default method can be found in the <component name>.cc file which islocated in the src-gen folder.

efactor Navigate Search Project Run Window Help
Siniia i ido - & Y B &ava [ Smartsoft| 2 Papyrus

& Project Explorer 3| & Navigator = O | @ compHandlercc X = o

« tent of this function to
v ¥ smartcdlServer

> = JRE System Library [JavasE-1.6]
> = Plugin Dependencies
> @sregen #
> @ model 26 status = COMP->comnectLasercLient (COMP->connections. LaserClient. servertiane, COWP->comections. laserclient. serviceiane);

8 Status = COMP->connec: nt. serverNane, COMP->connections.nawelsendClient.serviceNane);

if(COMP->getGlobalstate() .getserver() .getLaserClient2Init()) {
tatus = COMP->connectLaserClient2(COMP->connections. laserClient2. serverName, COMP->connections. laserClient2.serviceNane); =

1#(cOmP->getalobatstate()  getserver( ) .getpLamerinit()) {
= COMP->connectPlannerclient (COMP->connections. plannerClient. serverhane, COMP->connections.plannerClient.serviceliane);

LFCOMP->getlobatstate() getserver ) getTrackertnit()) (
= COMP->connectTrackingClient (COMP->connections. trackingClient. serverNane, COMP->connections. trackingClient.serviceNiane);

4F(COMP->getGlobalstate() getserver () .getIrCLientInit()) {
status = COMP->connectTrClient (COMP->connections. irClient. servertiane, COMP->connections.irClient.serviceNane);

}
@ CdlTriggerTimer.cc

if(c ).getserver () t0) {

4 CompHandler.

ompHandler.cc, status = COMP->connec Tient(C ions. pathiavigationGoalClient. serverName, COMP->connect: thiavigationGoalClient. serviceNane);
4 GoalTestHandler.cc 3

4 NawelsendHandler.cc 3 }

3 Parameterstatestruct.cc
4 RobotBlockedEventTestHandler.cc ctivate state sla
& smartCdiLookup.cc 308 Ctatus = Cowp-ascateaerver-sactivate();

if(Status 1= CHS: :SMART OK) std::cerr << "ERROR: activate state’ << std::endl:

& SmartCdiServerCore.cc

% Model Explore 18 -0 (3 Smartparameterditor & -

No selection.

No Model Available

Figure 2.21. Start services

2.3.3.3. Using Communication Objects

To be able to use communication objects inside a C++ implementation the corresponding SmartSoft
communi cation/coordination repository project hasto be compiled (cf. section 2.2.4) and the *.hh file
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of the communication object has to be included. If, for example, the communication object Comm-
NavigationVelocity should be used in the C++ implementation of a component, it has to be included
asfollows:

#i ncl ude " CommBasi cCbj ect s/ ConmmNavi gat i onVel oci ty. hh"
Now, the communication object can be instantiated:
ConmBasi cObj ect s: : ConmNavi gati onVel ocity vel ;
The attributes of the communication object can be accessed via getter and setter methods:

vel .set _vX(Xx);

vel . set _omega(onega) ;

/1 using the builder pattern, set nultiple values in one line:
vel . set _vX(x).set_onega(onega);

2.3.3.4. Using Services

There are different methods to exchange data for the different communication patterns. In the follow-
ing the most important methods are presented. Further information can be found in the SmartSoft/
ACE reference at http://servicerobotik-ulm.de/drupal/doxygen/aceSmartSoft/. For an example how to
use a service from your implementation, see fig. 2.22

1€l CdITask.cc 2

2 -int CdlTask::on_execute(){

/4 limit the calculated speed to the configured boundaries

calaculated_vX = std::max(localState.getCommNavigationObjects().getCdlParameter().getTRANSVEL().getVmin(), calaculated_vX);
calaculated_vX = std::min(localState.getCommNavigationObjects().getCdlParameter().getTRANSVEL().getVmax(), calaculated_vX);
// create and fill communication eobject

CommBasicObjects::CommNavigationVelocity vel;

vel.setVX(calaculated_vX);

vel.setOmega(calaculated_vwW);

/1 access service and send speed:

CHS::StatusCode status = COMP->nawVelSendClient->send(vel);
// print in case of errors

if(status != CHS::SMART_OK){

std::cout<<"Error sending speed: "<< CHS::StatusCodeConversion(status)<<std::endl;

+

return 0;

Figure 2.22. Exampleimplementation of atask using a service. [4]

event. The SmartEventClient subscribes for an event and receives the event result, which is provided
by the SmartEventServer.

SmartEventClient:

» StatusCode activate(const EventMode mode , const P& parameter, Eventld& id): Activate an event
with the provided parametersin either "single" or "continuous' mode.

« StatusCode deactivate(const Eventld id): Deactivate the event with the specified identifier. An event
must always be deactivated, even if it has already fired in single mode. Thisis just necessary for
cleanup procedures and provides a uniform user APl independently of the event mode. Calling
deactivate() while there are blocking calls aborts them with the appropriate status code.
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« StatusCode tryEvent(const Eventld id): Check whether event has already fired and return immedi-
ately with status information. This method does not consume an available event.

 StatusCode getEvent(const Eventldid, E& event): Blocking call whichwaitsfor theevent tofireand
then consumes the event. This method consumes an event. Returns immediately if an unconsumed
event is available. Blocks otherwise till event becomes available. If method is called concurrently
from several threads with the same id and thod is blocking, then every call returns with the same
event oncethe event fired. If thereis however already an unconsumed event available, then only one
out of the concurrent calls consumes the event and the other calls return with appropriate status
codes.

 StatusCode getNextEvent(const Eventldid, E& event): Blocking call which waitsfor the next event.
This methods waits for the next arriving event to make sure that only events arriving after entering
the method are considered. Method consumes event. An old event that has been fired isignored (in
contrary to getEvent()). If method is called concurrently from several threadswith the sameid, then
every call returns with the same event once the event fired.

SmartEventServer:
* StatusCode put(const S& state): Initiate testing the event conditions for the activations.

pushNewest. The SmartPushNewestServer provides datafor SmartPushNewestClientswhenever new
dataisavailable.

SmartPushNewestServer:
 StatusCode put(const T& d): Send updated data to all subscribed clients
SmartPushNewestClient:

 StatusCode getUpdate(T& d): Non-blocking call to immediately return the latest available data
buffered at the client side from the most recent update. No data is returned as long as no update
is received since subscription. To avoid returning old data, no data is returned after the client got
unsubscribed.

» StatusCode getUpdateWait(T& d): Blocking call which waits until the next update is received.
Blocking is aborted with the appropriate statusif either the client gets unsubscribed or disconnect-
ed or if blocking is not allowed anymore at the client.

pushTimed. The SmartPushNewestServer provides data in specified time intervals for SmartPush-
TimedClients.

SmartPushTimedServer:

* StatusCode put(const T& d): Provide new data which is sent to all subscribed clients taking into
account their individual update cycles. Update cycles are always whole-numbered multiples of the
server update cycle.

SmartPushTimedClient:

 StatusCode getUpdate(T& d): Non-blocking call to immediately return the latest available data
buffered at the client side from the most recent update. No data is returned as long as no update
is received since subscription. To avoid returning old data, no data is returned after the client is
unsubscribed or when the server is not active.

 StatusCode getUpdateWait(T& d): Blocking call which waits until the next update is received.
Blocking is aborted with the appropriate status if either the server gets deactivated, the client gets
unsubscribed or disconnected or if blocking is not allowed any more at the client.

query. The SmartQueryClient sends a request containing individual parameters and receives an indi-
vidual result from the SmartQueryServer.

SmartQueryClient:
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* StatusCode query(const R& request, A& answer): Perform a blocking query and return only when
the query answer is available. Member function is thread safe and thread reentrant.

* StatusCode queryRequest(const R& request, Queryld& id): Performaquery and receive the answer
later, returnsimmediately. Member function is thread safe and reentrant.

« StatusCode queryReceive(const Queryldid, A& answer): Check if answer isavailable. Non-block-
ing call to fetch the answer belonging to the given identifier. Returnsimmediately. Member function
isthread safe and reentrant.

* StatusCode queryReceiveWait(const Queryldid, A& answer): Wait for reply. Blocking call to fetch
the answer belonging to the given identifier. Waits until the answer is received.

* StatusCode queryDiscard(const Queryldid): Discard the pending answer with theidentifier id. Call
this member function if you do not want to get the answer of a request anymore which was invoked
by queryRequest(). This member function invalidates the identifier id.

SmartQueryServer:

 StatusCode answer(const Queryld id, const A& answer): Provide answer to be sent back to the
requestor. Member function is thread safe and thread reentrant.

send. The SmartSendClient provides datawhich is received by a SmartSendServer.
SmartSendClient:

* StatusCode send(const C& c): Perform a one-way communication. Appropriate status codes make
sure that the information has been transferred.

state and parameter. For descriptions on state and parameter, please refer to the doxygen reference
of SmartSoft/ACE. For an example how to use the parameter, please refer to the tutorial within this
handbook.

2.3.3.5. Status Codes

Status codes are used for the status and error handling when using SmartSoft methods, especially when
interacting with services. To convert a status code into readable ASCI| representation the following
method can be used:

std::string StatusCodeConversion(StatusCode code)
The method can be used as follows:

CHS: : St at usCode status = COWP->connect AndSt art Al | Servi ces();
i f(status !'= CHS:: SMART_OK) {

std::cout << "Error connecting services: " <<
CHS: : St at usCodeConver si on( st at us) ;

}

2.3.3.6. Component Wide Variables

Variables which should be accessible from all files of the component project can be declared in the
<component name>Core.hh file. To prevent the access of several threads at the same time a Mutex
should be added to this variables. The variable can be accessed as follows:

COVP- ><vari abl e nanme>
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Search Project Run Window Hel

Piavie @

Q
 Project Explorer 5 | % Navigator = O | B smartBluetoothLocalization

B & Java | [ Smartsoft| 72 Papyrus
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=0
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> B JRE System Library [Javase-1.6] A

» =i Plugin Dependencies 3

> @srcgen 44 |

. 45 #ifndef SMARTBLUETOOTHLOCALIZATIONCORE HH

> 4 Binaries © #define “SMARTBLUETOOTHLOCALIZATIONCORE HH

> G Includes

b e & #include "snartsoft.hh"

ot 49 #include <iostrean>

> @sregen 50 #include "C BeaconList. hh"

> & build 5

» = build 52 #include “ConnIndoorOutdoorNavigation0bjects/ComaLocation. hh*
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2 LocalizationTask.cc 65 CHS::SmartHutex conponentiideBeaconListhutex;
& LocationPushTimedHandler.cc 8 CHS:iSmarthutex locationMutex;
& Parameterstatestruct.cc 6 ComIndoorOutdoorNavigationObjects: :ComaLocation location;
9 SmartBluetoothLocalizationCore.cc 57
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No Model Available

lizationCore.

Figure 2.23. Add Component wide variables

A SmartMutex can be used to prevent simultaneous access of different threads. An example

of a mutex for a globa variable could be found in the component SmartBluetoothLocalization
(SmartBluetoothL ocalizationCore.hh):

Conm ndoor Qut door Navi gat i onCbj ect s: : Comm BeaconlLi st
conponent W deBeaconlLi st ;

CHS: : Smart Mut ex conponent W deBeaconLi st Mut ex;

To acquire or release the lock ownership of the component wide variable componentWideBeaconList,
the following code has to be used:

COWP- >component W deBeaconLi st Mut ex. acqui re();
COWP- >component W deBeaconlLi st . cl ear BeaconLi st () ;
COWP- >component W deBeaconLi st Mut ex. rel ease() ;

2.3.3.7. Using Parameters Within the Component

To access an attribute of a parameter within the component the following codeis used:

COWP- >get d obal St at e() . get <paranmeter name>().get<attribute
name>() ;

The settings.max_velocity, for example, is accesed as follows:
COWP- >get d obal State().get Settings().getMax_velocity();

In case these parameters change at runtime, we strongly recommend to work on a copy of the global
State:

Par amet er St at eStruct | ocal State = COWP->get d obal State();

34



Using the SmartMDSD Toolchain

| ocal St ate. get Settings().getMax_velocity();

2.3.4. Compile SmartSoft Component Projects

To be ableto use the devel oped components during system composition, they haveto be compiled. To
do so, right click on the SmartSoft component project and choose " Compile SmartMDSD Project” (cf.
figure 2.24).

[ Project|  nNew
Go Into

Ersmart  OpeninNew Window
Ersmart  ShowlIn
EISmart & copy
> & Smart & copy Qualified Name
> E=Smart g paste
> iZSmart i pelete
> 52 smart
Ersmart - puid path
TIsmart  pefactor
W smart
A
o smar 2 EXPOrE.-
&1 smart *l> Run SmartMDSD Code Generator
wrsmard®
& smart B Clean SmartMDSD Project
> Fsmart
Ersmart 1 Create SmartMDSD Distribution Package
rsmart  Build Project

Ersmart  CleanProject

> gHsmart & Refresh
Grsmart  Close Project
Ersmart  Close Unrelated Projects
Trsmart  Build Configurations
Trsmart  make Targets
Ersmart Index

smart
o Convert To...

RunAs
% ModelE  DebugAs
Profile As
Compare With
Restore from Local History...
#’ Run C/C++ Code Analysis
Team
"4 Discovery
(@ Paste
Plug-inTools
2 smartcd  Configure

Properties

Figure 2.24. Compile SmartSoft Component Pr oject

If the SmartSoft component project has to be compiled without the tool chain, navigate to the compo-
nent and enter the following commands:

nkdir build
cd build
cmake ..
make

In every component project and every communication/coordination repository folder, you will find a
cmake file CMakelLists.txt. Thisfile can be adjusted to add component-specific library dependencies.

2.3.4.1. Add Additional Libraries

In order to add external library dependencies (which should provide a cmake package definition) the
following lines have to be added to the file CMakel ists.txt:

FI ND_PACKAGE( <l i brary> REQUI RED <conponent s>)
GET_PROPERTY( <l i brary>_1 NCLUDE_DI RS DI RECTORY PROPERTY
| NCLUDE_DI RECTORI ES)

LI ST( APPEND USER | NCLUDES ${ <l i brary>_| NCLUDE_DI RS})

LI ST(APPEND USER LI BS ${<li brary>_LIBS})

If, for example, the libraries mrpt-base and mrpt-gui should be added, the following lines have to be
used:
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FI ND_PACKAGE( MRPT REQUI RED base gui)

GET_PROPERTY( MRPT_| NCLUDE_DI RS DI RECTORY PROPERTY
| NCLUDE_DI RECTORI ES)

LI ST(APPEND USER | NCLUDES ${ VRPT_| NCLUDE_DI RS})

LI ST(APPEND USER LI BS ${ MRPT_LI BS})

For further information on how to create cmake package-definitions for external libraries see: https://

cmake.org/Wiki/CMake:How_To_Find_Libraries

System libraries (e.g. installed in /ust/lib) can be added as follows:

LI ST(APPEND USER LI BS "<l i brary>")

The library libbluetooth, for example, can be added as follows:

LI ST(APPEND USER LI BS " bl uet oot h")

2.3.4.2. Add Compiler Flags

Additional compiler flags can be added to the CMakeL ists.txt as follows:

SET( CMAKE_CXX_FLAGS " ${ CMAKE_CXX_FLAGS} -<conpiler flag>")
For instance, in order to add the compiler flag "ENABLE_HASH" use thisline:

SET( CMAKE_CXX_FLAGS " ${ CMAKE_CXX_FLAGS} - DENABLE_HASH")

2.3.4.3. Add Your Own Source Files

All user source files inside of the src/ folder that have the ending .cc or .hh will be automatically
included into the build process of the component. In order to use a custom subfolder inside of the src/
folder add the following lines to the CMakeL ists.txt file:

FI LE(GLOB SRCS src/ <directory>/*.cc)
LI ST( APPEND USER_SRCS ${ SRCS})
LI ST(APPEND USER | NCLUDES src/ <di rectory>/)

An example can be found in the SmartVisualization component. The following lines were used to add
the source files of the directory "visualization":

FI LE(GLOB SRCS src/visualization/*.cc)
LI ST(APPEND USER _SRCS ${ SRCS})
LI ST(APPEND USER | NCLUDES src/visualization/)

In case the subdirectory contains an own cmake project, use the following approach instead:

ADD_SUBDI RECTORY( <pat h>)
LI ST(APPEND USER_| NCLUDES <pat h>)
LI ST(APPEND USER LI BS <l i brari es>)

An example is shown in the component SmartXsensIMUMTiServer:
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2.3.5.

ADD_SUBDI RECTORY( ${ PROUECT_SOURCE_DI R}/ sr c/ xsens SDK)

LI ST( APPEND USER | NCLUDES ${ PRQJECT_SCURCE_DI R}/ sr c/ xsensSDK/
Sof t war e_Devel opnment / CMTsr c)

LI ST(APPEND USER LI BS XSense)

Here is an example cmake project (for the X Sense SDK):

Smart Xsens| MUMTi Ser ver/ src/ xsensSDK/ CMakeLi sts. txt:
PRQIECT( XSense)

FI LE(GLOB SRCS ${ PRQJECT_SOQURCE DI R}/ Sof t war e_Devel opnent / CMTsr c/
*.cpp)

FI LE(GLOB HDRS ${ PROJECT_SCURCE_DI R}/ Sof t war e_Devel opment / CMTsr ¢/
*. h)

| NCLUDE_DI RECTORI ES( ${ PROJECT_SOURCE_DI R}/ Sof t war e_Devel opment /
CMTsr c)

ADD_LI BRARY( ${ PROJECT_NAVE} STATI C ${ SRCS} ${HDRS})

Component Documentation

To add additional document to the component use the *.compdoc file. Thisfileislocated in the mod-
el-folder. The component can be generally described with the 'Description’ keyword followed by a
colon and a string:

Description : <text>

Furthermore information about licences, hardware requirements and the general purpose of the com-
ponent can be added. To do so, the keywords ‘Licence, 'HardwareRequirements and 'Purpose’ are
used.

Li cence : <text>
Har dwar eRequi renents : <text>
Pur pose : <text>

The different states and services of the componend can also be described. A high level description
of states can be added with the keyword 'State neutral' or 'State_ Mainstate'. Thereby the keyword
'State neutral’ is used to describe the neutral state and the keyword 'State Mainstate' followed by the
name of the state to describe a mainstate.

State neutral : <text>
State Mainstate <name> : <text>

Services are documented with the keyword 'Service' followed by the name of the service. The descrip-
tion and further information about their behavior in specific states are enclosed by curly braces:

Servi ce <name> {
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Description : <text>
State _neutral : <text>
State_Mainstate <name> : <text>

}

From the textual parameter documentation, the information provided in the *.compdoc file and the
component model a documentation is generated with doxygen.

B [ *smartCdlServer_documentation.compdoc &2 = o

v 1 ComponentDocumen tatigomSmartCdlServer.SmartCdlServer{

bstacle avoidance.
e (DL algorithm is an improvement of the dynamic
window approach.”

Annotation of
License : "LGPL" documentation
Purpose : "Navigation” to component

1 State_neutral : "The robot will not move in state neutral.
State_Mainstate moverobot : "The robot will only move when

]
Reference to 12
component model and =
component elements 1

1

Component model
RGN Window  Help.

Service plannerclient{
Description : "Goals from planner (e.g. smartPlannerBrea
State_neutral : "Port is neutral, does not consume new i-

Full documentation

Provided-Ports Ifor system integration
7 *smartCdlserver.di & Generated [~ navvelsendserver
documentation =
<Component i v and w sent via this port will be considered when chosing a
SmartCdlServer trajectory. Can be used to send navigation commands from a joystick (e.g.

N S ~tucture « | SmartExampleJoystickNavigationClient) while the CDL ensures a collision free
B e e <Undefineds (1] e navigation. Accepts input if strategy JOYSTICK is set, ignores otherwise. See strategy
T JOYSTICK.

L «smartEventServer» (@] «smartPushNeweg
B* Undefined> [1] + plannerclient:

commPattern SmartSendServer

L «smartParameterSlave» moverobot «smartSendClient]
[&] + param: <Undefined> (1] [ stucture | + navVelSendcli

L «smartstateslave» commObject <
[&] + stateserver: <Undefined= (1] Q + trackingClient:

«smartTask» <smartPushNewed States:
[ + wiringSlave: <Undefined= (1] CdlTask + laserClient2: <l neutral : Port is neutral, does not consume new input while in this state.
Structure moverobot : CDL uses v, w from this port to chose best trajectory.
«smartC
= « goalEventServer
«Information» «smartComponentParameter»

Metadata Register with event state CDL_GOAL_NOT_REACHED to be notified when the stateful
event switches to event state CDL_GOAL_REACHED. The CDL_GOAL_REACHED will be
sent only once per activation. CDL_GOAL_REACHED: Is sent when a goal was reached

smartcdiserver &8 (the robot is within goal distance or angle error). - Depending on the strategy.
L I ]

Figure 2.25. Information from the documentation and component model is
transformed to a complete documentation (right) for later system integration
which assiststhe system integrator during composition. [4]

2.4. System Composition View

In addition to thefollowing description, the creation of asystem configuration and adepl oyment model
isshown in a screencast (cf. section 3.1.4 and section 3.1.6).

An application can be put together in the system composition View. For the application development,
a new SmartSoft deployment project has to be created. To do so, choose "File->New->SmartSoft
Deployment” (cf. figure 2.26), enter a name and choose a storage location. Typically the project is
stored at "$SMART_ROOT_ACE/src/deployments’ and its name starts with "Deploy” followed by
the application.

SmartSoft - Eclipse

File Edit Navigate Search Project Run Window Help

[ smartsoft Communication/Coordination Repository
oOpenFile... [ Smartsoft Component
B |

£ Project..

[ Example...

£ Other... Ctrl+N

™ Rename...
&1 Refresh
Convert Line Delimiters To

SwitchWorkspace
Restart

&3 Import...
4 Export...

Properties Alt+Enter

Exit

Figure 2.26. Create a new deployment proj ect
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2.4.1.

2.4.2.

Existing SmartSoft deployment projects can beimported by selecting "File->Import". In the appearing
dialog choose "General->Existing Projects into Workspace'.

The project contains a system configuration model and a deployment model. The system configura-
tion model is used to connect and configure components. The deployment model is used to map the
components of the system configuration model onto target hardware.

Before the system configuration or deployment model is altered, the graphical model of all used com-
ponents should be closed. If the component model is changed while the SmartSoft deployment model
is opened, the models might get out of sync.

System Composition Project

SmartSoft deployment projects contain various folders and files. For the development of applications
the following are important:

» model: Themodel folder containsthe graphical system configuration and deployment model (*.di).

» src: User-specific filesfor the deployment, typically hooksto execute commands before/after com-
ponent start/stop. It isinitially generated by the toolchain to provide a structure and standard files.

» src-gen Files generated by the SmartMDSD toolchain. Please do not modify these files, they will
be overwritten each time the toolchain generator is run.

75 Project Explorer &2 | %5 Navigator

¥ 5 DeployKbNavPlayerStageSimulator
» =) JRE System Library [JavaSE-1.6]
> =4 Plug-in Dependencies
> @Bmodel
* (= META-INF
¥ = model
> -3 DeployKbNavPlayerStageSimulator
Deployment.JPG
SystemConfiguration.JPG
¥ &=src
> (= SmartCdlServer_data
» (= SmartKeyboardNavigation_data
> (= SmartMorseBaseServer5_data
» = SmartPlayerstageSimulator_data
> (= SmartRobotConsole_data
# predeploy-smartcdlserver.sh
# predeploy-SmartKeyboardNavigation.sh
# predeploy-SmartMorseBaseServers.sh
# predeploy-SmartPlayerStageSimulator.sh
# predeploy-SmartRobotConsole.sh
# startstop-hooks-SmartCdlServer.sh

Figure 2.27. Structure of System Composition Projects

System Configuration

The system configuration is used to put together the application by (re)using building blocks such as
components as well as behavior models. Thereby only the outer view on the hull (services) aswell as
the explicated configurations of the components are presented in the model [4].

The system configuration model is part of the system composition project and is located in the mod-
el-folder.

2.4.2.1. System Configuration Model

The system configuration is modeled graphically. It consists of a SmartSystemConfiguration which
contains all building blocks. The name of the SmartSystemConfiguration must match the name of the
System Composition Project. In order to model component instances inside the system configuration
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the components have to be imported. To do so, right click on the system configuration model and
choose "Import Components'. The imported components are then listed in the model explorer and can
be added to the model via drag and drop. The name of the component instances can be changed in
the properties tab. After the component instance is added to the model no services are displayed. To
show/hide the border items right click on the component instance and select "Filters'->"Show/Hide
Contents'. Visible services can then be connected with a connector.

Figure 2.28 illustrates the modeling of the system configuration with the SmartMDSD Toolchain.
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Figure 2.28. Modeling System Configuration
2.4.2.1.1. Change Connections

Existing connections between two component instances can be changed by selecting the connector
element. The connection can then be atered through dragging the end of the connection to the new
communication port.

2.4.2.1.2. Delete Components From the Model

If a component should be deleted from the model all instances must be removed (right click on the
instance and choose "Delete Selected Element™). Then the imported component must be deleted in the
model explorer (right click on the imported element and choose "Delete").
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Figure 2.29. Delete Component from Model Explorer
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Additionally the component has to be deleted from the Java Build Path. To do so, right click on the
system composition project and select "Properties”. On the left hand side tree of the upcoming dialog
box select JavaBuild Path and switch to the "Projects” tab. The project can then be deleted by selecting
the project and pressing the "Remove" button. Figure 2.30 shows the dialog box.
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Figure 2.30. Delete Project from Java Build Path

2.4.2.2. Component Instance Configuration

To set the parameters of a component instance a SmartComponentParameter element has to be added
to the model of the instance. The parameter is then set as follows:

| mport Uri <pat h>

Depl oynent <i nstance nane>Depl oy i nstanti ates <conponent name> {
Par am <name> {

this.<attribute nanme> = <val ue>
}
}

Parameters are set with the keyword 'Param'’ followed by the name of the parameter and the attributes
which are enclosed by curly braces. The attributes which should be assigned with avalue are selected
with the this-operator.
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Figure 2.31. Configure component instance

System Deployment

2.4.3.1. Deployment model

The system deployment model is part of a SmartSoft system composition project and is located in
the model-folder. It is modeled graphically and contains SmartDevices, SmartArtifacts and a Smart-
NamingService.

An element is added to the deployment model by selecting the element in the tool palette and a left
mouse click on the model. Due to a bug in PapyrusUML the stereotypes are not applied correctly.
Therefore, the stereotypes have to be added manually. To this select the element and add the stereo-
type by clicking the "+"-button in the Properties tab (Properties->Profile). Figure 2.33 illustrates the
modeling of the system deployment with the SmartM DSD Toolchain.

» SmartDevice: The SmartDevice element isused to model target computersto which the components
are deployed. The following settings can be made:

* ip: Specifiesthe ip-address of the device. Default is 127.0.0.1

« loginName: Specifiesthelogin name of thedevice. If the valueisan empty string, thelogin name
will be the name of the current user logged in.

 deploymentDirectory: Specifiesthe storage location of the deployment. Default is ~/tmp/

* SmartArtifacts: SmartArtifactsare used to model component instanceswhich arealready modeledin
the system configuration model. For every component instance in the system configuration model a
SmartArtifact hasto be added. The modeled SmartArtifacts are distributed to atarget computer with
a deployment arrow from the target computer to the component instance. The following settings
can be made;

« utilizedComponentlnstance: Specifies the component instance. To sect the component instance
pressthe "..."-Button on the right, choose the instance in the appearing dialog and press the OK
button.

» SmartNamingService: The deployment model must contain exactly one SmartNamingService
which is distributed to a target computer with a deployment arrow. The following settings can be
made;
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 port: Specifiesthe port of the naming service. The default value is suitable for most use-cases.
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Figure 2.33. Modeling System Deployment

2.4.3.2. Code Generation

[ SmartNamingService
[2» SmartArtifact
[ SmartDevice

After the system configuration model and the deployment model are finished the code generator can
be started. To do so, right click on the SmartSoft deployment project and choose "Run SmartMDSD

Code Generator" (cf. figure 2.34).
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Figure 2.34. SmartSoft Deployment Code Generator
2.4.3.3. Target Considerations

The SmartMDSD Toolchain does not support cross-compilation. Therefore, the system deployment
has to be devel oped and executed on the same architecture.

All SmartSoft dependencies are deployed automatically. If additional libraries should be used, they
have to be added manually. To do so, adjust the script predeploy.sh. This script is generated for each
component in the model and is run prior to the deployment of the component. The script can be used
to add SmartSoft libraries that shall be deployed to the target device. These libraries will be searched
in $SMART_ROQT/lib. The libraries are added as follows:

DEPLOY_LI BRARI ES="$DEPLOY_LI BRARI ES <l i brary>. so"

2.4.3.4. Deploying Additional Files

If components should be deployed along with additional datafilesthey have to be added after the code
generation. After the code generation there exists a data-folder for every component instance inside
the src-folder to which additional datafiles can be added. The screencast in section 3.1.6 demonstrates
the deployment of components along with additional datafiles.

2.4.3.5. Start-Stop-Hooks

For every component in the model, a startstop-hooks script is generated. This script provides methods
to call custom commands pre/post of starting/stoping the component during launch on the device. This
script is being executed on the target device where the component is running. For exampl e the script
can be used to start and stop the morse simulator automatically.

2.4.3.6. Predeploy Infrastructure
For every component in the model, a predeploy script is generated. This script is run prior

to deployment of component. E.g. use this script to collect data-files and copy them to src/
<COMPONENT>_data, etc.

2.4.3.7. Deploying the Application

Precondition:
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Deployment isdone viascp which needs apassword. We suggest to setup an ssh-key: before deploying
an application create a ssh-key for the target device deployment once. To do so, enter in aterminal:

ssh- keygen
Then, use ssh-copy-id to transfer the key to the remote machine:

ssh-copy-id -i ~/.ssh/id_rsa. pub user @ost
Y ou should make sure that you can now login to the host without a password.
Deploying the application:
To deploy the application from the SmartMDSD Toolchain right click on the SmartSoft deployment
project and choose "Deploy + Run SmartMDSD Deployment”. After the deployment has finished, the
application can be started (cf. section 2.4.4.1). If the toolchain was started with aterminal, the ssh yes/
no as well as the password input are displayed in the terminal. If the toolchain was started with the

icon, these inputs are displayed in adialog.

To deploy the application without the toolchain, open aterminal and navigate to the deployment folder.
Then enter the following command:

bash src-gen/deploy-all.sh

2.4.4. Running the Application

2.4.4.1. Running the Application from Toolchain

The deployment and execution of an application is also demonstrated in a screencast (section 3.1.5).

To run the application from the toolchain right click on the SmartSoft deployment project and choose
"Deploy + Run SmartMDSD Deployment™ (cf. figure 2.35).
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Figure 2.35. Running the application from the toolchain
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Assoon asthe depl oyment finishes pressthe ™Y es"-Button on the appearing dialog. A terminal (Global
Scenario Control) is opened automatically (cf. figure 2.36). To start the application choose "menu-
start".

Scenario Control
Choose an option

menu-ztart Start Scenario
menu-stop  Stop Scenario

menu-tile Arrange terminals
quit (uit to conzole

<Ok {Cancel>

Figure 2.36. Global Scenario Control

To stop the application choose "menu-stop” in the global scenario control. After all components have
closed choose "quit".

2.4.4.2. Running the Application without the Toolchain

Y ou will find the deployment at the target folder that you specified in the deployment project. Default
is ~tmp/<DEPLOY MENT-PROJECT-NAME>.deploy. To start or stop the application enter:

bash start-PC.sh start
or

bash start-PC. sh stop
2.4.4.3. Component Output and Log Files
The components will be started in an terminal window. In case a component closes unexpectedly,
the window stays open and you can inspect the component output. Additionally, the output of al

components is kept in log-files which will be compressed once you close the deployment (*-logs-
* tar.gz).

2.5. Tips and Tricks
2.5.1. SmartSoft Full Build of Source Tree

Itispossibleto compilethe SmartSoft Kernel and all SmartSoft projectsthat arelocated inthedirectory
of the smartsoft repository checkout ($SMART_ROOT_ACE). To do so, open atermina and enter
the following commands:

cd $SMART_ROOT_ACE

nkdir build
cd build
cnmake ..
make
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To extend the list of components build in this run one can change CMakelLists.txt file in
$SMART_ROOT_ACE/src/components/.

2.5.2. SmartSoft and the RaspberryPi

Thereis (experimental) support of the ARM architecture and the RaspberryPi by the SmartSoft infra-
structure and components

However, the SmartMDSD Toolchain currently does not support cross-compilation. The SmartMDSD
Toolchain isin most cases used on a standard PC/x86 platform, while the RaspberryPi is based on
an ARM architecture. It istherefore not possible to use the SmartMDSD Tool chain with the Raspber-
ryPl. This section gives instructions on how to use the components and applications created with the
SmartMDSD Toolchain manually on the RasperryPi.

2.5.2.1. Preconditions

SmartSoft must beinstalled on the RaspberryPi. Use the provided install ation script that comeswith
SmartSoft; it automatically detects the RaspberryPi and adjusts the installation routine. Experimen-
tal support is available for Raspbian (confirmed with Raspbian Jessie/ 2015-11-21).

All described instructions must be executed from within the RaspberryPi graphical user interface/
X-Session or from ssh remote login with x forwarding option "ssh -X".

Optional: We recommend to make sure that you can login from RaspberryPi to localhost without a
password. We recomment to use ssh-copy-id to the Pl localhost.

Deployments will be made from the RaspberryPi to the RaspberryPi. Note that you can only deploy
to RaspberryPi devices. A deployment with two devices of different architectures (e.g. one Rasp-
berryPi and one x86) is not supported.

Note that the user and I P of the device in the deployment project have to align with the viewpoint
of the RaspberryPi. For most cases with one device, you can leave the IP at its default 127.0.0.1

2.5.2.2. Step by Step Instructions

Create / implement your projects as usual in the toolchain. Run the code generator for the deploy-
ment project in SmartMDSD Toolchain.

Make surethat al projects (deployment, components, comm-objs) are available on the RaspberryPi.
For example, use versioning control like SYN/GIT to keep them in sync, as you might want to
continue development on your development host (PC).

Compile all communication object projects and component projects manually. (Eventually delete
build/ from component folder, if you copied them from your development host)

$ cd <comm obj or component directory>
$ nkdir build

$ cmake ..

$ neke

Edit DEPLOY MENT-PROJECT/src-gen/referenced-projects and correct the absolute paths of the
component directories. Thisfileisgenerated by the SmartMDSD Tool chain but contains pathsfrom
the development computer. Depending on your setup, these paths may be wrong and you need to
correct them to match your RaspberryPi setup.

Now trigger the deployment action by executing the deployment script from the deployment project
directory.:

$ bash src-gen/deploy-all.sh

47



Using the SmartMDSD Toolchain

e You will find the deployment at the target folder that you specified in the deployment project.
Default is ~/tmp/<DEPLOY MENT-PROJECT-NAME>.deploy

» To start and stop the deployment, proceed as described in 2.4.4.2.

2.5.3. Delete Model Elements

If amodel element should be del eted, you should not use the del ete key of the keyboard. The delete key
hastwo different assignments. It can delete or hide the sel ected element. Dueto this doubl e assignment
the model element is not deleted reliably. To delete a model element, right click on the element and
choose "Delete Selected Element”. To make sure that elements are not part of the model anymore,
you can check so in the model explorer.

2.5.4. Common Error Messages

The SmartMDSD Toolchain contains basic checks of your models. The following sections list com-
mon error messages that might come up in such cases during code generation or compilation. They are
presented al ong with suggestions how to solve them. The error messages are shown in the Consol e-tab
of the toolchain (cf. figure 2.37).

a B &ava Ly Smartsort| 2 Papyrus

=0

% Model Explore 5

s/0pCube_neat.hpp
No Model Available s/fn_princonp_cov.hpp

Figure 2.37. Console tab of the SmartMDSD Toolchain

2.5.4.1. Component Development View

Error during Code generation:

* [ERROR]: No Metadata element defined. Please add one.: <component name>(Element:
ERROR:No Metadata element defined. Please add one.: <component name> ( line : null);
Reported by: -UNKNOWN-)

Thiserror messageis shown if no SmartComponentM etadata element was added to the component.
To solve the problem add a SmartComponentM etadata el ement to the component model.

* [ERROR]: 2 Metadata elements defined. Only one allowed.: <component name>(Element:
ERROR:2 Metadata elements defined. Only one allowed.: <component name> ( line : null);
Reported by: -UNKNOWN-)

This error message is shown if more than one SmartComponentM etadata element was added to
the component. To solve the problem remove the superfluous SmartComponentM etadata el ements
from the component model.

48



Using the SmartMDSD Toolchain

* [ERRORY]: Novalid communication object assigned for thisservice: <servicename>(Element:
ERROR:No valid communication object assigned for this service: <service name> ( line :
null); Reported by: -UNKNOWN-)

This error message is shown if no communication object is assigned to the service <service name>.
To solve the problem assign a communication object to the corresponding service.

* [ERROR]: Novalid smart<pattern>Handler set: <service name>(Element: ERROR:Novalid
smart<pattern>Handler set: <service name> ( line: null); Reported by: -UNKNOWN-)

This error message is shown if no valid handler is assigned to the service. To solve the problem
assign the corresponding handler to the service.

* [ERROR]: No SmartComponentParameter defined. Please add one.. <component
name>(Element: ERROR:No SmartComponentParameter defined. Please add one.: <com-
ponent name> ( line: null); Reported by: -UNKNOWN-)

This error message is shown if a smartParameterSlave but no SmartComponentParameter element
was added to the model. To solve the problem add a SmartComponentParameter to the model.

* [ERROR]: 2 Smart<pattern>Slaves defined. Only one allowed.: <component
name>(Element: ERROR:2 Smart<patter n>Slaves defined. Only one allowed.: <component
name> (line: null); Reported by: -UNKNOWN-)

This error message is shown if more than one smartWiringSlave, smartParameterSlave or smartS-
tateSlave was added to the model. To solve the error, delete the superfluous communicaiton ports.

Error during compilation:

» <path to component>/sr c-gen/<component name>.hh:25:34: fatal error: <communication ob-
ject name>.hh: No such fileor directory

This error message is shown if the communication object was not compiled. To solve the problem
compile the corresponding SmartSoft communi cation/coordination Repository (cf. section 2.2.4).

» <path to component>/src-gen/<component name>.hh:31:32: fatal error: <handler name>.hh:
No such fileor directory

This error message is shown if a handler but no corresponding communication port was added to
the model. To resolve the problem add the corresponding communication port.

2.5.4.2. System Composition View
Error during code generation:

 [ERROR]: No SmartNamingService defined: <deployment name>(Element: ERROR:No
SmartNamingServicedefined: <deployment name> (line: null); Reported by: -UNKNOWN-)

This error is shown if no SmartNamingService is modeled in the deployment model. To solve the
problem add a SmartNamingService element and connect it to the device.

* [ERROR]: No stereotype assigned. Please assign SmartArtifact or SmartNamingService:
<artifact name>(Element: ERROR:No stereotype assigned. Please assign SmartArtifact or
SmartNamingService: <artifact name> (line: null); Reported by: -UNKNOWN-)

This error message is shown if no stereotype is assigned to a SmartArtifact element in the deploy-
ment model. To solve the problem assign a stereotype to the SmartArtifact element by pressing the
"+"-putton in the properties tab.

* [ERRORY]: Artifact does not reference component (property: utilizedComponentl nstance):
<artifact name>(Element: ERROR:Artifact does not reference component (property: uti-
lizedComponentlnstance): <artifact name> ( line: null); Reported by: -UNKNOWN-)
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This error message is shown if no component instance was assigned to a SmartArtifact. To solve
the problem assign a component instance to the artifact in the properties-tab.

* [ERROR]: No stereotype assigned. Please assign SmartDevice: <device name>(Element:
ERROR:No stereotype assigned. Please assign SmartDevice: <device name> (line: null); Re-
ported by: -UNKNOWN-)

This error message is shown if no stereotype was assigned to a SmartDevice element. To solve
the problem assign the stereotype " SmartDevice" to the SmartDevice element by pressing the "+"-
Button in the properties tab.

 [ERROR]: Only the stereotype SmartDevice is allowed.: <device name>(Element:
ERROR:Only the stereotype SmartDeviceisallowed.: <device name> (line: null); Reported
by: -UNKNOWN-)

Thiserror messageis shown if astereotype other than " SmartDevice" or no stereotype was assigned
to a SmartDevice element. To solve the problem assign the stereotype " SmartDevice" to the Smart-
Device element.

* [ERROR]: No loginName set: <device name>(Element: ERROR:No loginName set: <device
name> ( line: null); Reported by: -UNKNOWN-)

This error message is shown if the loginName of a SmartDevice element is NULL. To solve the
problem change the value of the login name (an empty string is allowed).

Error during the deployment:

* ERROR: FILESARE MISSING FROM THE DEPLOYMENT (see above). Did you compile
all components?

This error message is shown if at least one component, which is used in the deployment, was not
compiled. To solve the problem make sure al used components are compiled (cf. section 2.3.4).
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Chapter 3. Tutorials

This chapter describes step-by-step tutorials (in written form and as video screencasts) to guide the
reader through all views of the SmartMDSD Toolchain to develop a practical example from scratch.

3.1. Video Tutorials

3.1.1.

3.1.2.

3.1.3.

This series of screencasts demonstrates the use of the SmartMDSD Toolchain. It can be used as a
walk-through tutorial through all stages of the development process and major functionalities of the
toolchain. Unless otherwise mentioned, the sequence of videos is in chronological order and each
extends or continues its predecessor.

Tutorial 1: Modeling of Communication Objects

This video demonstrates the modeling of Communication Objects using the SmartMDSD Toolchain.

The application in mind behind all examplesis arobot that drives around while avoiding any obsta-
cles. In thisvideo, aCommunication Object Repository (CommBasicObjects) is created with asimple
Communication Object CommNavigationVelocity that can be used to command navigation instruc-
tionsto arobot. The video also demonstrates how to model nested and more complex Communication
Objects (CommM obilel aserScan).

This video shows only an excerpt of the modeling of the repository CommBasicObjects which is
readily available within the SmartSoft distribution.

Link to the Video: [https.//www.youtube.com/watch?v=0x_nhFatO5w].

Tutorial 2;: Definition of a Parameter Set

This video demonstrates the modeling of a parameter using the SmartMDSD Toolchain.

Theapplicationin mind behind all examplesisarobot that drives around while avoiding any obstacles.
The parameter represents a configurable maximum velocity of arobot. This parameter can later bein-
stantiated by components. The maximum speed can then be configured through the parameter service.

(as shown in: [5] see Sides [http://servicerobotik-ulm.de/drupal/sites/defaul t/files/2014 2014-07-13-
RSS2014-Tutorial-Website.pdf])

Link to the Video: [https.//www.youtube.com/watch?v=2U4K xSgwtqY].

Tutorial 3: Component Development

This video demonstrates the modeling and implementation of a component using the SmartMDSD
Toolchain.

The application in mind behind all examplesis arobot that drives around while avoiding any obsta-
cles. The component receives laser scans. A simple obstacle avoidance a gorithm outputs values for
speed and direction. The component then threshol ds the maximum speed according to avariation point
(parameter "v_x", modeled in a previous video) before providing the navigation commands through
one of its services.

This parameter "v_x" can be configured during runtime of the component through its parameter ser-
vice.

(as shown in: [5] see Sides [http://servicerobotik-ulm.de/drupal/sites/defaul t/files/2014 2014-07-13-
RSS2014-Tutorial-Website.pdf])
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Link to the Video: [https.//www.youtube.com/watch?v=chyRCu4FCbsg].

3.1.4. Tutorial 4: System Configuration and Deploy-
ment Model

Thisvideo demonstrates the creation of system configuration and deployment model using the Smart-
MDSD Toolchain.

The application in mind behind all examplesisarobot that drives around while avoiding any obstacles.
The scenario: arobot shall drive and avoid obstacles. It reuses (existing) components SmartL aserOb-
stacleAvoid (see previous screencast), SmartLaserl MS200Server (laser ranger) and SmartPioneer-
BaseServer (robot).

The system configuration model models the connection and configuration of components. The de-
ployment model models the distribution of components on hardware.

(asshown in: [5] see Sides [http://servicerobotik-ulm.de/drupal/sites/defaul t/files/2014 2014-07-13-
RSS2014-Tutorial-Website.pdf])

Link to the Video: [https://www.youtube.com/watch?v=y-S33qaeNfl].

3.1.5. Tutorial 5: Deploying and Running an Applica-
tion

This video demonstrates the deployment and execution of an application developed using the Smart-
MDSD Toolchain.

The application in mind behind all examplesisaraobot that drives around while avoiding any obstacles.
The application (laser obstacle avoidance from a previous video) is deployed using SSH. A remote
session on the robot isestablished in order to runit. Therobot will first drive with amaximum velocity
of 600m/s (as configured in system configuration). Later, run-time configuration is used to change the
maximum velocity of the component to 200 and back to 600 every 5s via the parameter service and
explicated variation point v_x.

(as shown in: [5] see Sides [http://servicerobotik-ulm.de/drupal/sites/defaul t/files/2014 2014-07-13-
RSS2014-Tutorial-Website.pdf])

Link to the Video: [https:.//www.youtube.com/watch?v=0ZcC4ipt BM].

3.1.6. Tutorial 6: Deployment of components along
with additional files

This video demonstrates the deployment of components aong with additional data
files. It bases on a existing deployment diagram (DeployNavigationTaskPlayer SageSmu-
lator [http://sourceforge.net/p/smartsoft-ace/code/HEA D/tree/trunk/src/depl oyments/DeployNaviga-
tionTaskPlayerStageSimulator/]) and covers the steps from tutorial 5 with deploying additional files.

The example shows basic navigation components performing obstacle avoidance using the
SmartCdl Server component. The CDL algorithm makes use of local lookup files which need to be
deployed to the target host as well. This video shows how to deploy these files from within a deply-
oment project of the SmartMDSD toolchain.

This video also makes use of the Player Stage simulator component.

Link to the Video: [https://www.youtube.com/watch?v=JTww2aSBxac].
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3.2. Step by Step: Robot navigation
3.2.1. Introduction

This step by step tutorial shows a complete walkthrough through all steps of the SmartMDSD Tool-
chain to develop a robot navigation. The robot will be simulated in a 2D environment and shall be
controlled with a keyboard. Section 3.2.2 shows the modeling and implementation of the SmartKey-
boardNavigation component. After the component is developed two different examples of System
Compositions are made in section 3.2.3. The first alows the user to control the robot with the key-
board. The adds obstacle avoidance to thefirst example. All required components are available online.

The example consists of the following components:

» SmartKeyboardNavigation [http://sourceforge.net/p/smartsoft-ace/code/HEAD/treg/trunk/src/
components/SmartK eyboardNavigation/], which will be developed in this tutorial. It is also avail -
able online.

» SmartPlayerSageSmulator  [http://sourceforge.net/p/smartsoft-ace/code/HEAD/tree/trunk/src/
components/SmartPlayer StageSimul ator/]

e SmartCdlServer [ http://sourceforge.net/p/smartsoft-ace/code/HEA D/tree/trunk/src/compo-
nents/SmartCdl Server/]

» SmartRobotConsole  [http://sourceforge.net/p/smartsoft-ace/code/HEA D/tree/trunk/src/compo-
nents/SmartRobotConsol e/]

The SmartKeyboardNavigation component is used to control the robot with the keyboard. The Smart-
Player SageS mulator component simulates the robot in a2D environment. The SmartCdl Server com-
ponent is used for obstacle avoidance and the SmartRobotConsole is used to set parameters during
runtime.

3.2.2. Component Development (SmartKeyboardNavi-
gation)

In this section the SmartKeyboar dNavigation component will be model ed and implemented. To do so,
anew SmartSoft Component hasto be created. The name of this new component should be SmartKey-
boardNavigation.

After creating the project the component itself has to be modeled. The component should be able
to catch the keyboard input and send the current velocity of the robot. The keyboard input will be
received and processed with afew linesof C++ code. Thiscodewill runin an user thread, thereforethe
SmartTask "KeyboardinputTask" has to be added to the component. The thread should be executed
approx. every 500ms, therefor the KeyboardinputTask should be modeled periodically with a period
of 500ms (see figure 3.2).

To control the velocity of the robot a SmartSendClient "navVe SendClient” ismodelled. The velocity
issent with the"CommNavigationVelocity" Communication Object. This Communication Object can
be found in the CommBasicObjects repository for importing. The serverName and serviceName the
new SmartSendClient has to connect to can beleft blank. They will be set in the System Configuration
in the next step. Finally the SmartComponentM etadata has to be added to the component.

In summary the SmartKeyboardNavigation component consists of ;
» aSmartTask (name: KeyboardinputTask, isPeriodic: true, timeUnit: ms, period: 500)
» aSmartSendClient (name: navV el SendClient, commObject: CommNavigationV el ocity)

e aSmartComponentM etadata
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Figure 3.1 shows the modeled component.
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Figure 3.2. KeyboardlnputTask task with itstiming parameters.

After the component is modeled the c++ code of the component hull with itsinner and outer interfaces
has to be generated to start the implementation of the keyboard navigation component. To do so, the
user code has to be written in the generated "KeyboardlnputTask.cc" and "Keyboardl nputTask.hh"
user codefiles.

First of al it has to be possible to detect a keyboard input. To do so, the function kbhit() lis imple-
mented in the file "KeyboardinputTask.cc":

#i ncl ude <stdi o. h>
#i ncl ude <term os. h>
#i ncl ude <uni std. h>

! mplementation on kbhit taken from: http://choard.cprogramming.com/c-programming/63166-kbhit-linux.html
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#i ncl ude <fcntl. h>

int kbhit(void)

{
struct term os ol dt, newt;
int ch;
int ol df;

tcgetattr(STDI N_FILENO, &ol dt);

newt = ol dt;

newt.c_ | flag & ~(1 CANON | ECHO) ;

tcsetattr(STDI N_FI LENO, TCSANOW &newt);

ol df = fcntl (STDI N_FI LENO, F_CETFL, 0);

fent | (STDIN_FI LENO, F_SETFL, ol df | O_NONBLOCK);

ch = getchar();

tcsetattr (STDI N_FI LENO, TCSANOW &ol dt);
fcentl (STDI N_FI LENO, F_SETFL, ol df);

if(ch !'= ECF)

{

ungetc(ch, stdin);
return 1,

}

return O;

}

If a key is pressed the velocity of the robot has to be adjusted. The current speed control val-
ues are stored in task member variables "x" and "omega'. These variables are defined in the
"KeyboardlnputTask.hh" file:

cl ass Keyboardl nput Task : public Keyboardl nput TaskCor e
{

publi c:
Keyboar dl nput Task( CHS: : Smart Conponent *conp) ;
vi rtual ~Keyboardl nput Task();

virtual int on_entry();
virtual int on_execute();
virtual int on_exit();

doubl e x;
doubl e onega;

b

Depending on the pressed key the speed or the heading velocity has to be increased or decreased. To
do so, the following code has to be executed each time the task is executed.

i nt Keyboar dl nput Task: : on_execut e()

{
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i f(kbhit()) {
char ¢ = getchar();

/*Arrow keys*/

if (c =='\033") { // if the first value is esc
getchar(); // skip the [

switch(getchar()) { // the real value

case 'A':
std::cout << "Accelerating" << std::endl;
x += 150;
br eak;
case 'B':
std::cout << "Decreasing speed" << std::endl;
x -= 150;
br eak;
case 'C:
std::cout << "Shifting steering to right" << std::endl;
onega -= 0. 2;
br eak;
case 'D:

std::cout << "Shifting steering to left" << std::endl;
onega += 0. 2;

br eak;
}
[ *\WASD* /
lelse if(c =="'"w) {
std::cout << "Accelerating" << std::endl;
x += 150;
} elseif (c =="'d) {
std::cout << "Shifting steering to right" << std::endl;
onega -= 0. 2;
} elseif (c =="a) {

std::cout << "Shifting steering to left" << std::endl;
onega += 0. 2;

} elseif (c =="'s") {
std::cout << "Decreasing speed" << std::endl;
x -= 150;

} elseif (c =="'q) {
std::cout << "Emergency fullstop” << std::endl;
x = 0;
onega = O;

}

}

CommBasi cObj ect s: : ConmmNavi gat i onVel ocity vel ;
vel .set _vX(x);
vel . set _omega(onega) ;

CHS: : St at usCode status = COWP->navVel Sendd i ent - >send(vel);
}

If akey is pressed the x or omega variable will be adjusted. The velocity values are then stored in the
CommNavigationObject "vel" and send via the SmartSendClient "navV el SendClient".

In the example above the speed of the robot is increased or decreased by 150[mm/s] and the head-
ing velocity isincreased or decreased by 0.2[rad/s]. To make those values configurable store themin
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SmartComponentParameters. For this purpose a SmartComponentParameter has to be added to the
component model. Figure 3.3 shows the SmartKeyboar dNavigation component with an added Smart-
ComponentParameter.
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- O REEI R TOBRB YRR H e § o TR R HE R D e B/ R = EE
Ubuntu : 1. [ RETSIEASYE S TSy Q B & Java [y Smartsoft| 72 Papyrus
& Project Explorer 3 B % > =80 @ Task.cc (2 Comp i« =B hh =0
&1smartJoystickserver i Palette >
v 5 smartKeyboardNavigation [YCCN
> B JRE System Library [JavasE-1.6] & Nodes
> =i Plugin Dependencies  Edges
> @srcgen > smartsoft
» §2 Binaries ecomponents QsmartTask
> @ Includes structure QsmartTimer
Bsrc a + 2 smartsendHandler
> @srcgen amarbndin + 1 smartQueryHandler
> & build KeyboardinputTask I e + 1 SmartEventTestHandler
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tim;doeoen 1 (> SmartsystemConfiguration
> & METAINF f— ,
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mpdoc
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s nformation
[smartcomponentMetadatat

¥ & model

[@ CompHandler.cc

[ KeyboardinputTask.cc

2 Parameterstatestruct.cc
& smartKeyboardNavigationCore.cc
@ CompHandler.hh

14 KeyboardinputTask.h .| Bsmartkeyboardnavigation &

% Model Explorer % ! L] £ SmartparameterEditor %8 =
E®QABLDB S Parameter editor: SmartKeyboardNavig:
» E3 SmartKeyboardNavigation /] use ImportUri to import parameter definitions from Commobj repository

Component SmartKeyboardNavigation {
InternalParam Settings
@doc"Speed acceleration per keystroke [mm/s]."
speedAcceleration: Double = 150.0
@doc"Acceleration of the heading angle per keystroke [rad/s]."
angularAcceleration: Double =0.2
}

)

Figure 3.3. Adding parameters

Theinternal parameters speedAcceleration and angularAcceleration are added:

I nt er nal Param Setti ngs{
speedAccel eration : Double = 150.0
angul ar Accel eration : Double = 0.2

}

After adding the parameters the code has to be regenerated. Additionaly, the code of the
"KeyboardinputTask.cc" has to be adapted. The values 150 and 0.2 have to be exchanged by the cor-
responding parameters:

i nt Keyboardl nput Task: : on_execut e()
{
Par amet er StateStruct:: SettingsType | ocal state = COWP-
>get d obal State().getSettings();
i f(kbhit()) {
char ¢ = getchar();

/*Arrow keys*/
if (c =='\033") { // if the first value is esc
getchar(); // skip the [
switch(getchar()) { // the real value
case 'A':
std::cout << "Accelerating" << std::endl;
X += |l ocal st ate. get SpeedAccel eration();
br eak;
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case 'B':
std::cout << "Decreasing speed" << std::endl;
X -= local state. get SpeedAccel eration();
br eak;
case 'C:
std::cout << "Shifting steering to right" << std::endl;
onega -= | ocal st ate. get Angul ar Accel erati on();
br eak;
case 'D:

std::cout << "Shifting steering to left" << std::endl;
onmega += | ocal st ate. get Angul ar Accel erati on();
br eak;
}
[ *\WASD* /
lelse if(c =="'"w) {
std::cout << "Accelerating" << std::endl;
X += |l ocal st ate. get SpeedAccel erati on();

} elseif (c =="'d) {
std::cout << "Shifting steering to right" << std::endl;
onega -= | ocal st ate. get Angul ar Accel erati on();

} elseif (c =="a) {

std::cout << "Shifting steering to left" << std::endl;
onmega += | ocal st ate. get Angul ar Accel erati on();

} elseif (c =="'s") {
std::cout << "Decreasing speed" << std::endl;
X -= local state. get SpeedAccel eration();
} elseif (c =="'q) {
std::cout << "Emergency fullstop” << std::endl;
x = 0;
onega = O;
}

}

vel . set _vX(Xx);
vel . set _omega( onega) ;

CHS: : St at usCode status = COWP->navVel Sendd i ent - >send(vel);
}

With this the component modeling and implementation is done and the new component can be build

(cmake).
3.2.3. System Composition

3.2.3.1. System Composition 1. Simple Scenario

After all componentsare modeled and compiled they can be used in asystem configuration and deploy-
ment model. In this scenario arobot should be controlled with a keyboard. To do so, a new SmartSoft
Deployment Project has to be created and the following components have to be imported into the

System Configuration:
e SmartKeyboardNavigation

e SmartPlayerStageSimulator

Instances of these components have to be created in the System Configuration. Additionally, the ser-

vices
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» "navigationVelocitySendServer" of the SmartPlayer SageSmulator and
* "navVeSendClient" of the SmartKeyboardNavigation
have to be enabled and connected. To be able to change the values of the parameters a SmartCompo-

nentParameter is added to the instance of the SmartKeyboardNavigation component. In this example
the values are doubled.

Param Settings {
t hi s. speedAccel erati on = 300
t hi s. angul ar Accel eration = 0.4

}

Figure 3.4 illustrates the modeled System Configuration.

~? DeployKbNavPlayerStageSimulator.di &3

«smarkSystemConfiguration»
DeployKbNavPlayerStageSimulator
structure

+ SmartPlayerStageSimulator: SmartPlayerStagesi... \ | +SmartKeyboardNavigation: SmartKeyboardNav...
structure structure

+navigationVelocitySendServer: <Undefined> [1] +navVelSendClient: <Undefined>[1]

nsmaltCompnnEntParametEr»j

SystemConfiguration 53 | % Deployment

Figure 3.4. System Configuration

Additionally the Deployment has to be modeled. The Deployment contains the following elements:
» SmartDevice (name: PC)

» SmartNamingService (name: NamingService)

» SmartArtifact (name: KeyboardNavigation, utilizedComponentinstance: SmartKeyboardNaviga-
tion)

» SmartArtifact (name: PlayerStageSimulator, utilizedComponentlnstance: SmartPlayer StageSimu-
lator)

The Deployment isillustrated in figure 3.5.
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~# *DeployKbNavPlayerStageSimulator.di 2
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«smartDevice»

PC

SystemConfiguration % Deployment 3

Figure 3.5. Deployment
After generating and deploying the the Deployment project, the scenario can be started. After the
scenario is started the world (simulator) can be loaded by typing the corresponding number into the

SSH window. The robot can be controlled with the arrow keys or the WASD keys. To do so, the
commands have to be typed into the console window of the SmartKeyboardNavigation component.

3.2.3.2. System Composition 2: Adding obstacle avoidance

In the previous scenario (section 3.2.3.1) the robot will hit obstacles if the user does not avoid these
obstacles in time. To add obstacles avoidance, the following components have to be added to the
System Configuration:

* SmartCdl Server

» SmartRobotConsole

Instances of these components have to be added to the System Configuration. Additionally, the ser-
vices

» "laserServer" of the SmartPlayer SageSmulator and

* "navVelSendServer", "navVelSendClient", "laserClient" of the SmartCdl Server

have to be connected. The services has to be connected as follows:

* "navVeSendClient" (SmartKeyboardNavigation) - "navVel SendServer" (SmartCdl Server)
o "laserServer" (SmartPlayer SageSmulator) - "laserClient" (SmartCdl Server)

* "navigationVelocitySendServer" (SmartPlayer SageSmulator) - "navVelSend-
Client" (SmartCdl Server)

Additionally the parameter "plannernit" of the SmartCdl Server component hasto be set fal se, because
no path planning is used in this scenario. Furthermore the parameter "dataDir" has to be adjusted, be-
cause additional files are necessary for this component. To adjust the parameters of the SmartCdl Serv-
er component, a SmartComponentParameter has to be added to the component:
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Par am server {
this.plannerlinit = fal se

}

Par am cdl {
this.databDir = "./"

}

Theresulting System Configuration isillustrated in figure 3.6.

~? DeployKbNavPlayerStageSimulator.di 8

«smartSystemcConfiguration»
DeployKbNavPlayerStageSimulator
structure

+ SmartCdlServer: SmartCdIServer [1]

+ SmartPlayerStageSimulator: SmartPlayerStagesi... |

structure structure
+ navigationVelocitySendServer: <Undefined> [1] +navelSendClient: <Undefined [1]
+laserServer: <Undefined= [1] +laserclient: <Undefined=[1]

«smartComponentParameter»T

+SmartKeyboardNavigation: SmartKeyboardNav...
structure

«smartcomponenLParameLen»j

+navVelsendclient: <Undefined> [1] [F'—[; +navVelSendServer: <Undefined>[1]

+SmartRobotConsole: SmartRobotConsole [1]
structure

B systemConfiguration 52 | %3 Deployment

Figure 3.6. System Configuration

In addition the Deployment has to be adapted. Therefore, two additional SmartArtifacts have to be
added:

e SmartArtifact (name: CdlServer, utilizedComponentlnstance: SmartCdl Server)

» SmartArtifact (name: RobotConsole, utilizedComponentlnstance: SmartRobotConsol€)

Figure 3.6 shows the resulting Deployment.
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Figure 3.7. Deployment
After the code is generated the files
e CDLacc P3DX.dat,

» CDLcontour_P3DX.dat,

« CDLdist_P3DX.dat and

e CDLindex_P3DX.dat

have to be copied from $SMART_ROOQOT/data/cdl/ to the generated DeployK bNavPlayer StageSim-
ulator/src/SmartCdlServer_data folder. These files are required by the SmartCdl Server component
(cdl lookup files). Now, the scenario can be started. After choosing a world (simulator) the number
99 has to be typed into the SmartRobotConsole window. To enable the control of the robot with a
keyboard "Demo 4" has to be chosen afterwards by typing the number 4. The robot should now be
moving controlled by the users keyboard input, however avoiding collisions with obstacles.
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